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1 Introduction
1 Introduction

1.1 Target group

This documentation is aimed at users with the following knowledge and skills:

 Advanced KRL programming skills

 Advanced knowledge of the robot controller system

 Knowledge of field bus interfaces

 Knowledge of spot welding

1.2 Industrial robot documentation

The industrial robot documentation consists of the following parts:

 Documentation for the manipulator

 Documentation for the robot controller

 Operating and programming instructions for the KUKA System Software

 Documentation relating to options and accessories

 Parts catalog on storage medium

Each of these sets of instructions is a separate document.

1.3 Representation of warnings and notes

Safety These warnings are relevant to safety and must be observed.

Notes These hints serve to make your work easier or contain references to further 
information.

For optimal use of our products, we recommend that our customers 
take part in a course of training at KUKA College. Information about 
the training program can be found at www.kuka.com or can be ob-

tained directly from our subsidiaries.

These warnings mean that it is certain or highly probable 
that death or severe physical injury will occur, if no pre-

cautions are taken.

These warnings mean that death or severe physical inju-
ry may occur, if no precautions are taken.

These warnings mean that minor physical injuries may 
occur, if no precautions are taken.

These warnings mean that damage to property may oc-
cur, if no precautions are taken.

These warnings contain references to safety-relevant information or 
general safety measures. These warnings do not refer to individual 
hazards or individual precautionary measures.

Tip to make your work easier or reference to further information.
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1.4 Trademarks

Windows is a trademark of Microsoft Corporation.

WordPad is a trademark of Microsoft Corporation.

1.5 Terms used

Term Description

Burn-off (tip 
wear)

Deformation of the electrode tips caused by the weld-
ing process or by tip dressing

Compensation 
(equalization)

Pneumatic compensation cylinder for compensating 
the position of the gun:

 Compensation activated: “soft” gun position

 Compensation deactivated: “exact” gun position

First initializa-
tion

Pressing in the new electrode tips and remeasuring the 
tip burn-off (EG_WEAR[])

Mastering Definition of the zero point (closed position) of the weld 
gun

Calibration Comparison of the force sensor with an external force 
gauge and calculation of the following characteristics:

 Force characteristic

 Gun flexion characteristic

Tip dressing 
(TippDress)

Restoring the profile of the electrode tips by cutting

Force build-up Generation of the closing force during gun closure

Force gauge Instrument for measuring the closing force of the weld 
gun

Force control During force control, the position of the axis/gun is cor-
rected until the force acting on the gun is equal to the 
setpoint force (welding force).

Force sensor Sensor in the motor of the spot weld gun, for determin-
ing the welding force

Position control During position control, the position of the axis/gun is 
corrected until the setpoint position is reached.

Pole pair Signal pick-up in the resolver of the gun motor

A pole pair consists of two poles.

Reset Resetting the force sensor (zeroing)

Residual travel The residual travel is the distance between the soft-
ware limit switch and the hardware limit stop; serves to 
protect the spindle and motor.

Weld timer (= weld controller)

Device for controlling the welding time and welding cur-
rent

SDC Servo Digital Converter

The SDC is a hardware expansion required for Servo-
Gun FC. It is located on the RDC box.

Servo gun Weld gun with servomotor drive

Trace The trace is the recorded measurement curve for a 
parameter, which is determined using the controller 
tool.
Issued: 10.04.2012 Version: KST ServoGun FC 2.0 V4 en



1 Introduction
Water monitor Monitoring unit in the cooling water circuit of the weld 
gun. The water monitor monitors the cooling water vol-
ume at the input and output of the cooling water circuit.

Exchangeable 
gun

Exchangeable weld gun which can be decoupled from 
the gun mount on the robot by the program

Gun flexion Deformation of the weld gun caused by the action of 
the closing force

Gear ratio Ratio between the motor stroke and gun opening

Cyclical initial-
ization

Determination of the current electrode burn-off and 
adjustment to the current closing position

Term Description
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2 Product description
2 Product description

2.1 ServoGun FC – overview

Functions ServoGun FC is an add-on technology package with the following functions:

 Force control of the gun via force sensor

 Control of up to 6 force-controlled, electric motor-driven spot weld guns:

 Up to 6 exchangeable guns

 1 stationary spot weld gun and up to 5 exchangeable guns

 2 stationary spot weld guns

If a linear unit is used:

 Up to 5 exchangeable guns

 Or 1 stationary spot weld gun

 Force calibration of guns

 Automatic TCP correction after tip dressing (electrode burn-off)

 Monitoring of various parameters

The servo gun is implemented as an external axis. Every taught point contains 
the positions of the 6 robot axes and the opening width of the gun.

WorkVisual The following software is required for configuring the servo guns:

 WorkVisual 2.2

EqualizingTech The software KUKA.EqualizingTech is available as a supplement to Servo-
Gun. With EqualizingTech, conventional gun compensation systems are no 
longer required. This makes it possible to dispense with e.g. the complicated 
start-up procedures for pneumatic compensation systems. EqualizingTech re-
sults in only minor changes in the operation of ServoGun for the user.

Cell overview

Information about installing EqualizingTech is contained in the KU-
KA.EqualizingTech documentation.

Fig. 2-1: Overview of a welding cell
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2.2 Functional principle

The robot approaches the taught weld spot using position control. Before the 
gun makes contact with the workpiece, the robot is braked to a defined veloc-
ity. The gun closes and presses the workpiece together. When the switch-on 
threshold (normally 0.8 kN) is reached, the robot controller switches from po-
sition control to force control (during the motion). The gun continues to press 
the workpiece together under force control until the welding force is reached. 
The signal for the start of welding is set, and the force on the gun is controlled 
during the welding process. The spot is welded. During the welding process, 
the force sensor measures the force acting on the gun and transfers the mea-
surement result to the robot controller. When the weld timer gives the signal 
for the end of welding, the robot controller switches back to position control, 
and the gun opens.

1 KR C4 robot controller

2 Weld timer

3 Tool rack

4 Robot

5 Energy supply system

6 Stationary servo gun

7 Servo gun

8 Tip dresser

Fig. 2-2: Position and force control during the welding cycle

FZ Measured force acting on the gun

t Time

1 Welding force reached

2 Force reaches switch-on threshold

3 Electrodes in contact with the workpiece

4 Switchover to force control on reaching the switch-on threshold

5 Weld timer starts and the spot is welded

6 Weld timer signals the end of welding; switchover to position 
control

7 Electrodes lift off the workpiece and the gun opens
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2 Product description
2.3 Overview of connecting cables

The following connections depend on the type of weld gun being used:

 Connection for water cooling of the weld gun and the motor

 Air connection for the gun compensation

 Connection for the weld current

Fig. 2-3: Overview of connecting cables

1 Weld timer

2 Robot controller

3 Resolver-sensor cable

4 Motor cable to the gun

5 Weld gun

6 Field bus module on the weld gun (Not necessary if EqualizingTech is 
used. Otherwise, depending on the weld gun used.)

7 Field bus connection between the following components:

 Weld timer

 Robot controller

 If used: Field bus module on the weld gun

8 Robot

Further information about the connections on the weld gun can be ob-
tained from the gun manufacturer.
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2.4 Electrical connections on the weld gun motor

2.5 Connector pin allocation X52

Description The connector is a 19-contact (16+3) Intercontec connector with female crimp 
contacts on the P side.

Fig. 2-4: Position of the electrical connections on the weld gun motor

Fig. 2-5: Electrical connections of the weld gun motor

1 Connection for motor cable

2 Connection for resolver-sensor cable

Further information can be found in the parts list of the energy supply 
system.
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2 Product description
The shields of the wire pairs for "24 V sensor" (pin 1) / "GND sensor" (pin 2) 
and "Analog IN" (pin 3) / "Digital OUT" (pin 8) are connected to the connector 
housing.

Fig. 2-6: Connector pin allocation X52

Pin Designation

1 24 V sensor (IO-2)

2 GND sensor (IO-2)

3 Analog IN (IO-2)

4 n. c.

5 n. c.

6 n. c.

7 n. c.

8 Digital OUT (IO-2)

9 n. c.

10 SIN OUT 4+ (R1)

11 SIN OUT 4- (R2+)

12 n. c.

13 S2

14 S4

15 S1

16 S3

17 GND TMP (temp.)

18 TMP 7 (temp.)

19 n. c.
15 / 93Issued: 10.04.2012 Version: KST ServoGun FC 2.0 V4 en



16 / 93

KUKA.ServoGun FC 2.0
Issued: 10.04.2012 Version: KST ServoGun FC 2.0 V4 en



3 Safety
3 Safety

This documentation contains safety instructions which refer specifically to the 
software described here. 

The fundamental safety information for the industrial robot can be found in the 
“Safety” chapter of the Operating and Programming Instructions for System In-
tegrators or the Operating and Programming Instructions for End Users.

The “Safety” chapter in the operating and programming instructions 
must be observed. Death to persons, severe physical injuries or con-
siderable damage to property may otherwise result.

The force signal is measured in analog form at the sen-
sor box without electrically isolated voltage supply. This 

measurement can be disrupted by discharged currents from the welding pro-
cess. Interference is particularly liable to occur if the following constellation is 
used in the cell:

 The secondary neutral of the welding transformer is grounded.

 And: the workpiece fixture (e.g. a clamping fixture) is grounded.

It must be ensured that the force signal is transmitted to the sensor box with-
out any interference. In particular, the constellation described above must not 
be used in the cell. If this precaution is not observed, the robot controller 
might receive corrupted force signals. Physical injuries or damage to proper-
ty may result.

If the secondary neutral of the welding transformer is not 
grounded, this will endanger persons working at the cell. 

In particular, a voltage of 500 V is liable to be generated on the gun and not 
discharged. To avoid this hazard, one of the following elements must be in-
stalled in the primary weld power supply:

 Isolating contactor

 Residual-current circuit-breaker matching the welding technology (medi-
um frequency or mains frequency)

Failure to observe this may result in severe physical injuries or death to per-
sons.

Weld spots and tip dressing points that were taught with-
out EqualizingTech having been installed, must not be 

used with EqualizingTech.
Weld spots and tip dressing points that were taught with EqualizingTech 
must not be used without EqualizingTech. 
The points must be retaught. Damage to the gun or the workpiece may oth-
erwise result.
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4 Installation
4 Installation 

4.1 System requirements

Hardware  KR C4 robot controller

 Robot with SDC

 Energy supply system with sensor cable for force-controlled electric mo-
tor-driven spot weld gun

If a stationary gun is used: Suitable connecting cable

 Servo gun with force sensor

Software  KUKA System Software 8.2

4.2 Installing ServoGun FC

Preparation  Copy the folder with the software from the CD to the USB stick.

Precondition  “Expert” user group

Procedure 1. Connect the USB stick to the robot controller or smartPAD.

2. In the main menu, select Start-up > Install additional software.

3. Click on New software. The entry ServoGun FC must be displayed in the 
Name column and drive E:\ or K:\ in the Path column.

If not, press Refresh.

4. If the specified entries are now displayed, continue with step 5.

If not, the drive from which the software is being installed must be config-
ured first:

 Click on the Configuration button. A new window opens.

 Select a line in the Installation paths for options area. 

Note: If the line already contains a path, this path will be overwritten.

 Press Path selection. The available drives are displayed.

 Select E:\. (If stick connected to the robot controller.)

Or select K:\. (If stick connected to the smartPAD.)

 Press Save. The window closes again.

The drive only needs to be configured once and then remains saved for 
further installations.

5. Mark the entry ServoGun FC and click on Install. Answer the request for 
confirmation with Yes.

6. Confirm the reboot prompt with OK.

7. Remove the stick.

8. Reboot the robot controller.

LOG file A LOG file is created under C:\KRC\ROBOTER\LOG.

During installation of ServoGun, one gun is automatically installed as 
external axis E1. Any existing E1 is overwritten.
If the gun is to be assigned to a different external axis number, this 

must be configured in WorkVisual.
All other configuration settings affecting the external axis must also be per-
formed in WorkVisual.

Recommendation: Use a KUKA stick. Data may be lost if 
any other stick is used.
19 / 93Issued: 10.04.2012 Version: KST ServoGun FC 2.0 V4 en



20 / 93

KUKA.ServoGun FC 2.0
4.3 Uninstalling ServoGun FC

Precondition  “Expert” user group

Procedure 1. In the main menu, select Start-up > Install additional software.

2. Mark the entry ServoGun_FC and click on Uninstall. Reply to the request 
for confirmation with Yes. Uninstallation is prepared.

3. Reboot the robot controller. Uninstallation is resumed and completed.

LOG file A LOG file is created under C:\KRC\ROBOTER\LOG.

It is advisable to archive all relevant data before uninstalling a soft-
ware package.
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5 Operation
5 Operation

5.1 Menus

The following menus and commands are specific to this technology package:

Main menu:

 Configuration > Status keys > ServoTech

 Configuration > ServoGun Force Control

 Inputs

 Outputs

 Configuration

 Gun parameters

 Force control

 Load all

 Save all

 Configuration > ServoGun Diagnosis

 Configuration > Servo Gun Parameter Tool

Menu sequence Commands > ServoTech:

 SPOT

 PTP, LIN, CIRC

 INIT

 TippDress

 PTP, LIN

 ServoGun Decouple

 ServoGun Couple

5.2 Status keys

Procedure Displaying the status keys:

 In the main menu, select Configuration > Status keys > ServoTech.

Description Status key Name / description

Toggle status keys

Displays additional status keys.

First initialization

Cyclical initialization

Gun

Gun to which the status keys refer

Compensator 1

Close gun with compensator 1

 (>>> 5.5 "Manually activating gun compensation" 
Page 23)
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5.3 Manually opening / closing the gun

Precondition  Operating mode T1

 Settings on the Keys tab in the Jog options window: 

 The check box Activate keys is activated.

 Under Kinematic groups, a group is selected that contains the exter-
nal axis, e.g. External axes.

The type and number of kinematics groups available depend on the 
system configuration.

 Under Coordinate system, the option Axes is selected.

Procedure 1. Set jog override.

2. Hold down the enabling switch.

3. The axes of the selected kinematics group are displayed next to the jog 
keys.

 Press the “plus” key of the external axis to close the gun.

 Press the “minus” key of the external axis to open the gun.

5.4 Manually coupling / decoupling the gun

Description The gun is coupled or decoupled by the software.

Procedure 1. Select the gun using the Gun status key.

2. Couple the gun with the Couple status key, or decouple it using Decou-
ple.

Compensator 2

Close gun with compensator 2

 (>>> 5.5 "Manually activating gun compensation" 
Page 23)

Decouple

 (>>> 5.4 "Manually coupling / decoupling the gun" 
Page 22)

Couple

 (>>> 5.4 "Manually coupling / decoupling the gun" 
Page 22)

Status key Name / description

If the functions of the status keys are interchanged (i.e. if the gun 
opens when “plus” is pressed), the sign of the configuration parame-
ter Gear ratio must be changed.

Further information about axis combinations and external axes in 
general can be found in the documentation External Axes.

The opening width of the gun must be identical in both the coupling 
and decoupling position. Recommendation: The gun should be 
open at least 10 mm.

Do not decouple the gun if it is in the mastering position, since the mastering 
would otherwise be lost when the gun is recoupled.
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5 Operation
5.5 Manually activating gun compensation

Description This functionality can be used to check the pneumatic compensation.

Precondition  T1 or T2 operating mode

 The gun is coupled.

Procedure 1. Move the gun to the panel/position where the check is to be carried out.

2. Select the gun using the Gun status key.

3. Press the status key Compensator 1 or Compensator 2. The gun closes 
and opens again after 0.5 s.

4. If the panel deforms in an undesired manner, change the setting of the 
pneumatic compension on the gun.

5. Repeat steps 3 and 4 until compensation is carried out as desired.

5.6 Calling the variable overview

Description The variable overview displays the different ServoGun parameters and the 
corresponding values.

Procedure  In the main menu, select Display > Variable > Overview > Display. The 
variable overview is opened.

This function is not required if EqualizingTech is installed.

Information about the meaning of the parameters can be found in the 
chapter “System variables”.
 (>>> 9 "System variables" Page 77)
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6 Start-up and configuration
6 Start-up and configuration

6.1 Start-up and configuration – overview

The force signal is measured in analog form at the sen-
sor box without electrically isolated voltage supply. This 

measurement can be disrupted by discharged currents from the welding pro-
cess. Interference is particularly liable to occur if the following constellation is 
used in the cell:

 The secondary neutral of the welding transformer is grounded.

 And: the workpiece fixture (e.g. a clamping fixture) is grounded.

It must be ensured that the force signal is transmitted to the sensor box with-
out any interference. In particular, the constellation described above must not 
be used in the cell. If this precaution is not observed, the robot controller 
might receive corrupted force signals. Physical injuries or damage to proper-
ty may result.

If the secondary neutral of the welding transformer is not 
grounded, this will endanger persons working at the cell. 

In particular, a voltage of 500 V is liable to be generated on the gun and not 
discharged. To avoid this hazard, one of the following elements must be in-
stalled in the primary weld power supply:

 Isolating contactor

 Residual-current circuit-breaker matching the welding technology (medi-
um frequency or mains frequency)

Failure to observe this may result in severe physical injuries or death to per-
sons.

Step Description

1 Mount the gun.

2 Connect the connecting cables.

3 Enter the weld parameters in the weld timer, e.g. welding 
time, welding current, dressing time.

Note: Information can be found in the documentation for 
the weld timer.

4 Install ServoGun TC.

5 If required: Install EqualizingTech.

6 Transfer the project to WorkVisual and carry out configura-
tion via WorkVisual.

Then transfer the project from WorkVisual back to the robot 
controller.

 (>>> 6.2 "Configuration in WorkVisual – overview" 
Page 26)

7 Calibrate the gun as the tool.

Note: Observe the information about servo gun calibration 
in this documentation.

 (>>> 6.3 "TCP calibration and tool direction" Page 29)

8 Enter and save the gun names.

 (>>> 6.4 "Setting configuration parameters" Page 29)
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6.2 Configuration in WorkVisual – overview

9 Configure the inputs/outputs.

 (>>> 6.4.3.1 "“Inputs” screen" Page 31)

 (>>> 6.4.3.2 "“Outputs” screen" Page 33)

10 Configure the parameters for Configuration.

With the exception of the following parameters: Force 
gauge, First calibration position, Calibration steps

 (>>> 6.4.3.3 "“Configuration” screen" Page 34)

11 Configure the parameters for Maximum gun force in kN. 
(configuration screen Force control)

 (>>> 6.4.3.5 "“Force control” screen" Page 35)

12 Master the gun.

 (>>> 6.5 "Manual gun mastering" Page 37)

13 Determining the gear ratio.

 (>>> 6.6 "Determining the gear ratio" Page 37)

14 Determine the thickness of the force gauge.

 (>>> 6.7 "Determining the thickness of the force gauge" 
Page 38)

15 Test the sensor reset.

 (>>> 6.8 "Testing the sensor reset" Page 38)

16 Determine the calibration step size.

 (>>> 6.9 "Determining the calibration step size" Page 39)

17 Calibrate the force sensor.

 (>>> 6.10 "Calibrating the force sensor" Page 40)

18 Set the software limit switches for the gun.

 (>>> 6.11 "Setting the software limit switches" Page 44)

19 Check the residual travel and software limit switches.

 (>>> 6.12 "Checking the residual travel and software limit 
switches" Page 45)

20 Carry out first initialization of the electrode tips.

 (>>> 6.13 "Tip initialization – overview" Page 50)

21 If required: Optimize the controller parameters.

 (>>> 6.14 "Controller parameters – overview" Page 51)

Step Description

Step Description

1 Transfer the project from the robot controller to WorkVisual.

2 Configure the field bus.

3 Configure the controller bus.

 (>>> 6.2.1 "Controller bus configuration for KUKA.Servo-
Gun FC" Page 27)

4 Configure the gun.

 (>>> 6.2.2 "Configuring the gun" Page 27)

5 If required: perform further settings in WorkVisual.

6 Transfer the project from WorkVisual to the robot controller.
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6 Start-up and configuration
6.2.1 Controller bus configuration for KUKA.ServoGun FC

SDC topology The SDC is connected to connection B of the RDC. The connection is a per-
manent connection (= not disconnectable).

6.2.2 Configuring the gun

Description

The following guns/combinations can be configured:

 Up to 6 exchangeable guns

 1 stationary spot weld gun and up to 5 exchangeable guns

 2 stationary spot weld guns

If a linear unit is used:

 Up to 5 exchangeable guns

 Or 1 stationary spot weld gun

Preparation 1. Copy the file ServoGunFC.afc from the Catalogs folder on the ServoGun 
CD.

2. Copy the file to the following folder on the PC on which WorkVisual is in-
stalled: 

C:\Progam Files\KUKA\WorkVisual…\Catalogs

3. Import the catalog in WorkVisual via File > Catalog management....

The catalog is now displayed in the Catalogs window. 

Precondition  The robot controller has been set as the active controller.

Procedure 1. Select the gun in the ServoGun […] catalog in the Catalogs window.

2. Drag the gun into the Project structure window: into the Hardware tab, 
onto the robot controller there. (Not onto the node Unassigned active de-
vices.)

3. If the gun is used as a stationary gun, continue directly with step 4.

If it is used on the robot flange, select the Geometry tab. There, drag the 
gun onto the Flange Base node of the robot.

(This specifies that the gun may be coupled to this robot. It does not spec-
ify whether the gun is actually coupled, but merely that coupling is possi-
ble.)

Information about bus configuration and project deployment can be 
found in the WorkVisual documentation.

During installation of ServoGun, one gun is automatically installed as 
external axis E1. Any existing E1 is overwritten.
If the gun is to be assigned to a different external axis number, this 

must be configured in WorkVisual.
All other configuration settings affecting the external axis must also be per-
formed in WorkVisual.

KUKA Roboter GmbH must be consulted if guns are to be used that 
are not contained in the catalog.

The guns are named after their motors. If the name does not contain 
any specification of the gun type, then it does not matter which gun 
type the motor is combined with in reality.
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4. Select the gun and select the menu sequence Editors > Machine data 
configuration. The Machine data configuration window is opened.

5. Only if this ServoGun project has already been transferred 2 or more times 
to WorkVisual:

Click on the following button: Import axis-specific machine data of the 
kinematic system from external files

6. If the tab [Axis_name] (e.g. Joint 1) is closed, click on it. The tab is opened.

7. In the Axis ID box in the area General axis-specific machine data, spec-
ify which drive the gun is assigned to in the real cell.

8. Fill out the Supply channel box.

9. Set the check mark in the box Axis decouplable.

10. If required: edit the other parameters.

11. Repeat steps 1 to 9 for all the guns used. 

12. Only with stationary guns: The gun must be linked to the robot with which 
it is to be kinematically coupled in the real cell.

a. Select the cell on the Hardware tab and select the menu sequence 
Editors > Configure kinematic relations…. An editor opens.

(If couplable guns are used, these are linked to their robot in the editor 
by means of arrows. This is only a display and cannot be changed 
here.)

b. Right-click in the empty space in the editor and select  from the 
context menu.

c. Click on the stationary gun. Hold down the mouse button, drag the 
mouse pointer to the robot and release the mouse button.

In the editor, the link is now displayed by an arrow line. The designa-
tion of the gun is now displayed in the node of the robot on the Hard-
ware tab.

d. Repeat these steps for all stationary guns used.

13. Switch back to the Machine data configuration window.

14. Only perform in the following case:

 If this project has been configured in WorkVisual for the first time.

 And if one or more guns had already been configured manually on the 
robot controller before the project was transferred to WorkVisual.

Click on the following button: Import axis-specific machine data of the 
kinematic system from external files

System variables The following ServoGun system variables are adapted by the configuration in 
WorkVisual:

EG_EXTAX_ACTIVE

EG_SERVOGUN_EXAXIS[1] … [6]

EG_COUPLE_AXIS

If the data are not imported in the specified case, config-
uration data may be lost, resulting in a faulty project be-

ing transferred to the robot controller. This may result in damage to property 
or necessitate extensive corrective measures.

If the data are not imported in the specified case, config-
uration data may be lost, resulting in a faulty project be-

ing transferred to the robot controller. This may result in damage to property 
or necessitate extensive corrective measures.
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6 Start-up and configuration
6.3 TCP calibration and tool direction

 When calibrating the servo gun, always position the TCP on the fixed elec-
trode. 

 The tool direction must be defined as shown in the illustration (plus and mi-
nus directions).  (>>> Fig. 6-1 )

 In the KUKA System Software, the X, Y or Z direction can be selected as 
the tool direction. 

The direction that was selected there must be entered during the configu-
ration of ServoGun on the configuration screen Configuration. (Default: -
X direction)

 (>>> 6.4.3.3 "“Configuration” screen" Page 34)

6.4 Setting configuration parameters

Precondition  “Expert” user group

Procedure 1. In the main menu, select Configuration > ServoGun Force Control and 
then one of the following menu items:

 Inputs

 Outputs

 Configuration

 Gun parameters

 Force control

The corresponding configuration screen is opened. 

2. If there is more than one gun configured: In the Selected gun box, select 
the gun (no.) to which the settings are to apply.

3. Enter a distinctive name for the gun in the Gun description box.

Information about calibration and definition of the tool direction is con-
tained in the operating and programming instructions for the KUKA 
System Software (KSS).

Fig. 6-1: TCP and tool direction
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4. Configure the parameters as required on the selected screen.

 (>>> 6.4.3 "Configuration parameters" Page 31)

5. Press Save. The changes are saved.

6. Close the screen via the Close icon.

7. Configure the parameters as required on the other screens.

Alternative 

procedure

The parameters can also be loaded from a data medium.

 The parameters can be loaded for each screen. 

 (>>>  "Buttons" Page 30)

 The parameters can be loaded for a number of screens at once. 

 (>>> 6.4.1 "Loading gun data from a TXT file" Page 30)

Buttons The following buttons are available on the configuration screens:

6.4.1 Loading gun data from a TXT file

Description If the data for the following configuration screens are available in a TXT file, 
they can be loaded at once:

 Configuration

 Gun parameters

 Force control

Precondition  The TXT file is located on a drive to which the robot controller has access.

Or: A USB stick with the TXT file is connected.

 “Expert” user group

Procedure 1. In the main menu, select Configuration > ServoGun Force Control > 
Load all.

2. All available drives are displayed. Navigate to the TXT file and select it.

3. Click on Load.

This needs to be done only once per gun, on one of the screens.

Button Description

Import If the data for this screen are available in a TXT file, they 
can be loaded using this button. 

Precondition: The TXT file is located on a drive to which 
the robot controller has access. Or a USB stick with the 
TXT file is connected.

Export Saves the data in this screen to a TXT file. A name can 
be assigned to the file. As the memory location, it is pos-
sible to select a drive to which the robot controller has 
access, or a USB stick.

Load Updates the data in this screen in accordance with the 
current state of the robot controller. 

If changes have been entered but not yet saved on this 
screen, the initial state can be restored in this way.

Save Saves the changes on this screen.

Calculate Only available in the Force control screen.

Calculates the current calibration of the gun on the ba-
sis of the values Force 1 in kN, etc. The calibration is 
not saved.
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6 Start-up and configuration
4. A request for confirmation is displayed, asking if the existing data should 
be overwritten. Confirm with Yes.

The data are loaded.

6.4.2 Saving gun data in a TXT file

Description This procedure saves the data in the following configuration screen to a TXT 
file:

 Configuration

 Gun parameters

 Force control

Precondition  “Expert” user group

Procedure 1. If data are to be saved to a USB stick, this should be connected.

2. In the main menu, select Configuration > ServoGun Force Control > 
Save all.

3. The available drives are displayed. Navigate to the desired memory loca-
tion and select it.

4. Enter a name for the file in the Select file box.

5. Click on OK. The data are saved and the following message is displayed: 
Saving successful!

6.4.3 Configuration parameters

6.4.3.1 “Inputs” screen

Digital inputs/

outputs

Digital inputs/outputs 1 to 4096 are available by default. This number can be 
reduced via the variable $SET_IO_SIZE.

Inputs/outputs If an input or output is set, the LED icon next to the box is green (otherwise 
gray).

Fig. 6-2: Lamps for inputs/outputs

Input Description

Motion with/without 
closing

HIGH = Gun remains open at the weld spot 

LOW = Gun closes at the weld spot 

Weld end HIGH = End of weld reached 

LOW = End of weld not reached 

Error messages For customization 

Address range for transfer of error messages from the weld timer 

Error from timer HIGH = Error from weld timer present 

LOW = No error from weld timer present 
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Acknowl-

edgement by PLC

The following dialog messages can be acknowledged by the PLC:

 No cycle end signal, input ..., repeat point?

With/without weld 
current

Weld instruction executed with/without current. 

In AUT and EXT modes, an error message is displayed if the weld cur-
rent is deactivated.

HIGH = With weld current 

LOW = Without weld current 

Option tip dressing Not supported

For customization

Acknowledge with-
out repeat

Certain dialog messages can also be answered by the PLC instead of 
the user. These two inputs receive the answer from the PLC.  
(>>>  "Acknowledgement by PLC" Page 32)

HIGH for Acknowledge without repeat = NO (The program is contin-
ued without repeating the point.)

HIGH for Acknowledge with repeat = YES (The last point is repeated.)

Both inputs must not be HIGH at the same time. If both inputs are LOW, 
this means “no answer”, and the message remains in the message win-
dow.

Note: After the dialog message has been answered, the input must be 
reset by the PLC for the program to be resumed.

Acknowledge with 
repeat

New electrodes For customization

Stop after end of 
point

Robot stops after weld instruction.

HIGH = Robot stops 

LOW = Robot continues to move 

Dressing start 
request

For customization

Dressing follow 
request

For customization

Timer valid bit Weld timer confirms program number.

HIGH = Weld timer confirms program number 

LOW = No confirmation from the weld timer 

Timer ready Status of weld timer

HIGH = Weld timer ready 

LOW = Weld timer not ready 

Process monitoring For customization

Water monitor 1 Monitoring of the cooling water volume at the gun intake 

HIGH = No alarm 

LOW = Alarm triggered 

Water monitor 2 Monitoring of the cooling water volume at the gun outflow 

HIGH = No alarm 

LOW = Alarm triggered 

Thermo contact 
transformer

Monitoring of the temperature of the transformer on the gun 

HIGH = Transformer has normal operating temperature

LOW = Transformer is overheating 

Input Description
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6 Start-up and configuration
 Welding controller error, input ..., repeat point?

 No TIMER READY signal, input ..., repeat point?

6.4.3.2 “Outputs” screen

Digital inputs/

outputs

Digital inputs/outputs 1 to 4096 are available by default. This number can be 
reduced via the variable $SET_IO_SIZE.

Inputs/outputs If an input or output is set, the LED icon next to the box is green (otherwise 
gray).

Fig. 6-3: Lamps for inputs/outputs

Output Description

Weld start Start the welding process (also start of cycle) 

HIGH = Start of welding 

LOW = No start of welding 

Compensator 1 Only effective for gun with pneumatic compensation: activate compen-
sator 1 

HIGH = Compensation activated

LOW = Compensation deactivated

Compensator 2 Only effective for gun with pneumatic compensation: activate compen-
sator 2

HIGH = Compensation activated

LOW = Compensation deactivated

Program number Address range for transfer of the program number. The bit width must 
not exceed 32 bits.

HIGH = Bit set 

LOW = Bit not set 

With/without weld 
current

This input is LOW if the timer type “TEST” or T1 mode is selected.

Otherwise, this input is HIGH.

Acknowledge weld 
error

Reset error in the weld timer 

HIGH = Error will be reset 

LOW = Error will not be reset 

New electrodes This output is used by the robot controller to signal to the weld timer that 
first initialization with new electrodes has taken place.

Stop after end of 
point

Confirmation, stop after end of welding 

HIGH = End of weld reached 

LOW = End of weld not yet reached 

Acknowledge tip 
dressing

For customization
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6.4.3.3 “Configuration” screen

Input Description

Timer type Manufacturer of the weld timer used

If TEST is selected, the gun is closed for 0.5 seconds with the define 
force and then opened again. No welding is carried out.

 TEST (default), ARO, BOSCH, FASE, SERRA

Gun type  X: X gun (default)

 C, G, J: C gun

TCP orientation Working direction of the tool (TCP)

 -X (default), -Y, -Z, +X (default), +Y, +Z

 (>>> 6.3 "TCP calibration and tool direction" Page 29)

TCP correction Automatic correction of the point coordinates, corresponding to the tip 
wear

 On (default): The point coordinates are corrected, i.e. they are adapt-
ed in accordance with the tip wear determined during tip initialization.

 Off: The point coordinates are not corrected. If the burn-off has been 
determined, this is ignored.

Tip detection The system checks for the presence of tips on the gun.

 On (default): Tip detection activated.

If an electrode tip falls off, this is detected and an error message is 
generated. After force build-up, the closing width of the gun is mea-
sured. This value is compared with the value entered under Part in 
the inline form TippDress, taking into account the flexion.

 Off: Tip detection deactivated

X-Compensation Maximum comp.: The distance traveled by the tips at maximum force.

 0 ... 10 mm

Default: 0.00

Direction: The direction in which the tips travel.

 -X (default), -Y, -Z, +X (default), +Y, +Z

Compensation active: X-compensation on/off

 Off (default), On

Force gauge Thickness: Thickness of the force gauge

 0 … 100 mm

Default: 50.00

 (>>> 6.7 "Determining the thickness of the force gauge" Page 38)

Calibration posi-
tions

First calibration position: First measurement position during calibra-
tion.

 0 … 100 mm

Default: 0.10

Calibration steps: Size of the calibration step for the 4 subsequent 
measurements of the calibration in [mm/kN].

 0 … 100 mm

Default: 0.10
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6.4.3.4 “Gun parameters” screen

6.4.3.5 “Force control” screen

First Init force The force with which the gun is closed during the first motion during first 
initialization

Note: Suitable values are values from 2.5 kN.

 2 … max. gun force

Default: 3.00

Tip wear (burn-off) Maximum permissible value of the tip burn-off (both tips together)

 0 … 20 mm

Default: 8.00

Input Description

Input Description

Motor file The files currently used are displayed here.

(display only)

If other files are to be loaded, this must be done in WorkVisual.

Servo file

Position control file

Force control file

Gear ratio Distance moved by electrodes in [mm] per revolution of the motor

 -100 … 100 mm

Default: 5.00

Note: Enter the value without sign, or with a positive sign.

 (>>> 6.6 "Determining the gear ratio" Page 37)

Max. opening (mm) Enter the negative software limit switch.

 0 … 1,000 mm

Default: 100.00

 (>>> 6.11.1 "Setting the negative software limit switch" Page 44)

Software limit (mm) Enter the positive software limit switch.

 0 … 1,000 mm

Default: 35.00

 (>>> 6.11.2 "Setting the positive software limit switch" Page 45)

Max. flexion (mm) Maximum flexion of the gun (calculated from the calibration) + 5 mm 
reserve

(display only)

Max. speed (rpm) Revolutions per minute of the gun motor

(display only)

Input Description

Force 1 in kN …

Force 5 in kN

Enter here the values determined during calibration.

Default: 0.001

Force 1 in Inc …

Force 5 in Inc

These values are determined during coarse and fine calibration and dis-
played here automatically.

(display only)
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Calibration position 
1 in degrees …

Calibration position 
5 in degrees

Gun positions during the 5 calibration measurements. The values are 
displayed here automatically.

(display only)

Position / Force Ratio of position (degrees) to force (kN)

(display only)

Force-control 
switch-on in kN

Switching threshold between position control and force control (kN)

 0.1 … 10.00

Default: 0.80

Recommendation: Do not change the default value.

Maximum gun force 
in kN

Enter the maximum closing force of the gun. This can be taken from the 
gun manufacturer’s data sheet. (kN)

 1 … 10.00

Default: 5.00

Note: If this maximum force cannot be achieved on the force gauge dur-
ing determination of the calibration step size, then enter here the highest 
force measured on the force gauge.

 (>>> 6.9 "Determining the calibration step size" Page 39)

Proportional factor Gain factor of the force controller

 0.00001 … 1.00

Default: 0.01

Recommendation: Do not change the default value.

Lower limit in kN Tolerance relative to the switch-on threshold, below which the force 
must not drop during force control (kN)

 0 … 2.00

Default: 2.00

Recommendation: Do not change the default value.

Upper limit in kN Tolerance relative to the maximum force of the weld gun, which must not 
be exceeded during force control (kN)

 0 … 2.00

Default: 0.50

Recommendation: Do not change the default value.

Max. speed of con-
stant motion phase 
(rpm)

Maximum speed of the constant motion phase (rpm).

Default: 1000.00

Recommendation: Do not change the default value.

Workpiece detection 
monitoring toler-
ance

Factor which is multiplied by the value of Maximum gun force in kN 
and then converted into a distance, taking account of the gun flexion 
(Max. flexion (mm)). If this distance is exceeded after contact with the 
workpiece has been detected, without the force sensor signal exceeding 
the force controller switch-on threshold, then it is assumed that there 
has been a fault in the measuring chain (force sensor, splitter box, sen-
sor cable, A/D converter module) and the robot stops.

 0.5 … 1

Default: 0.50

Recommendation: Do not change the default value.

Input Description
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6.5 Manual gun mastering

Description A gun must be mastered in the following cases:

 Commissioning a gun (first mastering)

 After exchanging gun components

 After a loss of mastering

Precondition  Operating mode T1

 New electrode tips are fitted on the gun.

Procedure 1. Close the gun manually with the jog keys until the electrodes are just 
touching. 

Whether or not the electrodes are just touching can be ascertained by a 
visual check, or using a strip of paper held between the electrodes. (Close 
the gun until the strip of paper is lightly clamped.)

2. In the main menu, select Start-up > Master > Dial. A window opens.

3. In this window, select the external axis to be mastered and press the Mas-
ter softkey. The axis is removed from the window.

4. Close the window.

6.6 Determining the gear ratio

Precondition  The gun is mastered.

 Operating mode T1

Procedure For C guns:

The gear ratio corresponds to the screw pitch of spindle.

1. Consult the gun manufacturer’s data sheet to find out the value for the 
screw pitch of spindle.

2. Enter the value in the Gear ratio box in the Gun parameters configuration 
screen and save.

If no value for the spindle screw pitch is available from the manufacturer, the 
gear ratio can be determined using the same method as for X guns.

For X guns:

The gear ratio is the change in the opening width over 1 motor revolution.

1. Close the gun without exerting any force.

2. In the main menu, select Display > Actual position. The Cartesian actual 
position is displayed.

3. Press Axis-specific to display the axis-specific actual position. The gun 
position is displayed as 0 in the Motor [deg] column.

4. Open the gun manually until the value 360 is displayed in the Motor [deg] 
column.

5. Measure the distance between the electrodes.

6. Enter the distance in the Gear ratio box in the Gun parameters configu-
ration screen and save.

Used electrodes must not be used in this case, as this 
would result in an incorrect mastering value. This could 

damage the gun.

The gun must not exert any force, otherwise it may be-
come damaged.
37 / 93Issued: 10.04.2012 Version: KST ServoGun FC 2.0 V4 en



38 / 93

KUKA.ServoGun FC 2.0
6.7 Determining the thickness of the force gauge

Description The thickness of the sensor plate of the force gauge is determined and entered 
in the configuration. This is the basis for measuring the closing forces of the 
gun with the force gauge during subsequent gun calibration.

Precondition  The gun is mastered.

 Operating mode T1

Accessories  Force gauge

Procedure 1. Set jog override to 3%.

2. Open the gun manually.

3. In the main menu, select Display > Variable > Overview > Display. 

4. Place the force gauge on the fixed electrode.

5. Close the gun until the moving electrode just touches the sensor plate.

6. In the Variable overview – Display window, read and note down the val-
ue for the Position variable.

7. Open the gun and remove the force gauge.

8. Enter the value in the Thickness box in the configuration screen Config-
uration.

6.8 Testing the sensor reset

Precondition  The gun motor is connected.

 The outputs are configured.

 The gun is mastered.

The value for the gear ratio is more precise if the gun is opened by 
more than one motor revolution and the measured distance is divided 
by the number of revolutions.

Recommendation: If there is sufficient space available, open the gun by 10 
revolutions and then divide the measured distance by 10.

Fig. 6-4: Measuring with the force gauge
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Procedure If there is an LED on the distributor box of the weld gun motor:

1. Set the system variable $SG_SENSOR_RESET[axis_number] to TRUE.

The LED must light up.

2. Set the system variable $SG_SENSOR_RESET[axis_number] to FALSE.

The LED must go out.

If there is no LED on the distributor box of the weld gun motor:

1. Set the system variable $SG_SENSOR_RESET[axis_number] to TRUE.

Carefully close the gun manually. At the same time, observe 
$FORCE_ACT: $FORCE_ACT must maintain the same value.

2. Set the system variable $SG_SENSOR_RESET[axis_number] to FALSE.

Carefully close the gun manually. At the same time, observe 
$FORCE_ACT: $FORCE_ACT must increase continuously as the actual 
force increases.

6.9 Determining the calibration step size

Description The calibration step defines the ratio between the travel and the force [mm/kN] 
of the gun and must be determined for the coarse calibration.

Precondition  The gun is mastered.

 The electrode tips are firmly pressed on.

 The gear ratio has been entered.

 The thickness of the force gauge has been entered.

 The maximum gun force has been entered.

 Operating mode T1

Accessories  Force gauge

Procedure 1. Set jog override to 3%.

2. Open the gun manually.

3. In the main menu, select Display > Actual position > Cartesian. 

4. Place the force gauge on the fixed electrode.

5. Close the gun until the force gauge shows a value of approx. 0.8 kN.

6. Note the actual position of the external axis.

7. Continue to close the gun until the maximum gun force is displayed on the 
force gauge.

If the maximum force is not reached, note the highest force achieved.

8. Note the actual position of the external axis at maximum force.

If the maximum force was not reached in the previous step, note the actual 
position at the highest force achieved.

9. Open the gun and remove the force gauge.

10. Calculate the first calibration position and the size of the calibration step.

 (>>> 6.9.1 "Calculating the first calibration position and the calibration 
step size" Page 40)

11. Enter the value in the boxes First calibration position and Calibration 
steps in the configuration screen Configuration.

If the LED or $FORCE_ACT responds in a different way 
from that described, the force sensor is supplying incor-

rect values. There is a risk of damage to the gun and/or the workpiece.
Check the cabling and correct if necessary.
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12. If the maximum force specified by the manufacturer is not reached on the 
force gauge, enter the highest force achieved on the configuration screen 
Force control under Maximum gun force in kN.

6.9.1 Calculating the first calibration position and the calibration step size

Example values

First calibration 

position

First calibration position = Force gauge thickness – Actual position for max-
imum force

First calibration position = 23 mm – 21 mm

Result: 2 mm

Calibration steps Calibration steps = (Actual position for maximum force – Actual position for 
lower force) / 4

The divisor “4” is determined by the number of calibration steps for coarse cal-
ibration.

Calibration steps = (21 mm – 3 mm) / 4

Result = 4.5 mm

6.10 Calibrating the force sensor

During calibration, the force sensor is compared with an external force gauge 
and the gun flexion is determined.

Overview

The programs can only be executed in T1 mode.

Thickness of the force gauge 23 mm

Lower gun force Always use the following value:

0.8 kN

Maximum gun force If the maximum force specified by 
the manufacturer is not reached on 
the force gauge, enter the highest 
force achieved.

3.4 kN

Actual position for lower force 3 mm

Actual position for maximum force 21 mm

Step Description

1 Coarse calibration with EG_CAL_F program

 (>>> 6.10.1 "Coarse calibration with EG_CAL_F program" 
Page 41)

 (>>> 6.10.2 "Description of coarse calibration" Page 41)

2 Force test with EG_FORCE_F program

 (>>> 6.10.3 "Force test with EG_FORCE_F program" 
Page 43)

3 Only necessary if the force test with EG_FORCE_F results in 
too high a deviation between the setpoint and actual force val-
ues:

Fine calibration with the EG_RECAL_F program

 (>>> 6.10.4 "Fine calibration with the EG_RECAL_F pro-
gram" Page 43)
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6 Start-up and configuration
6.10.1 Coarse calibration with EG_CAL_F program

 (>>> 6.10.2 "Description of coarse calibration" Page 41)

Precondition  The gun is mastered.

 The gear ratio has been entered.

 The thickness of the force gauge has been entered.

 The maximum gun force has been entered.

 The calibration step size and first calibration position have been entered.

 New electrode tips

 Operating mode T1

Accessories  Force gauge

Procedure 1. Select and start the program EG_CAL_F.

2. Follow the dialog messages and note the values of the 5 measurements.

3. After the 5th measurement, take the force gauge out of the gun.

4. The gun moves to the mastering position and stops there. Carry out a vi-
sual check that the mastering position is correct.

 If it is: continue with the next step.

 If not: remaster the gripper. Then repeat the entire calibration.

5. Execute the program through to the end.

6. The values noted must be entered on the Force control configuration 
screen in Force 1 in kN to Force 5 in kN.

7. Click on Calculate, then save.

6.10.2 Description of coarse calibration

The program EG_CAL_F is used to determine the relationship between the 
force sensor increments and the external force, and between the gun position 
and the external force. This results in the following characteristics:

 Force characteristic of the force sensor

During calibration, the gun closes at process velocity, not 
at test velocity.

If it becomes apparent during the measuring process that 
the maximum gun force will be exceeded at the next 

measuring step, the EG_CAL_F program must be aborted. If this is not done, 
the force gauge and/or gun may be damaged.
On the configuration screen Configuration, a lower value must be entered 
under Calibration steps. Then restart EG_CAL_F. 

If the force gauge is not removed from the gun, this may 
result in damage to property.

The measured values should cover the force range of the gun. If the 
measured values are too low, a higher value must be entered at the 
following place: On the configuration screen Configuration under 

Calibration steps.
Then restart EG_CAL_F.
The force range is dependent on the gun. Guide values: 

 Force 1 in kN: 0.8 kN … 1.2 kN

 Force 5 in kN: Maximum force
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 Gun flexion characteristic

The program EG_CAL_F closes the gun under position control. The resulting 
force value is determined using a force gauge.

In 5 measurements, 5 increment/force pairs are determined. The increment/
force pairs are saved and added to the force characteristic of the force sensor, 
with interpolation of the intermediate values.

The gun flexion characteristic is calculated from the force values, the motor 
position and the gear ratio.

Fig. 6-5: Force characteristic

Fext Force on the external force gauge

Pos Measurement position (in force sensor increments)

F1...F2 Measured forces at the measurement positions

1...5 Measurement positions

Fig. 6-6: Force / gun flexion characteristic

G Gun flexion in mm

F Force in kN
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6 Start-up and configuration
6.10.3 Force test with EG_FORCE_F program

Description The EG_FORCE_F program is used to check the force characteristic. A force 
sensor is placed in the gun. The user selects the force with which the gun is to 
be closed.

The robot controller closes the gun with the selected setpoint force. The actual 
force on the gun can then be read off on the force gauge.

Precondition  The gun is mastered.

 The gear ratio has been entered.

 The thickness of the force gauge has been entered.

 The maximum gun force has been entered.

 The calibration step size and first calibration position have been entered.

 Coarse calibration with EG_CAL_F has been carried out.

 Operating mode T1

Procedure 1. Select and start the program EG_FORCE_F.

2. Follow the dialog messages.

3. Select the lowest setpoint force using the corresponding button. 

4. Measure the actual force with the force gauge and note it down.

5. Repeat steps 3 and 4 for all forces.

The -> button is used to display further buttons with higher forces.

6. If the actual force values deviate from the setpoint values by more than 
±3%, carry out fine calibration with the program EG_RECAL_F. 

 (>>> 6.10.4 "Fine calibration with the EG_RECAL_F program" Page 43)

6.10.4 Fine calibration with the EG_RECAL_F program

Description If the force test with EG_FORCE_F results in too high a deviation between the 
setpoint and actual force values, fine calibration must be carried out. 
EG_RECAL_F performs the same measurements as EG_CAL_F, but closes 
the gun under force control.

Precondition  The gun is mastered.

 The gear ratio has been entered.

 The thickness of the force gauge has been entered.

 The maximum gun force has been entered.

 The calibration step size and first calibration position have been entered.

 Coarse calibration with EG_CAL_F has been carried out.

 Operating mode T1

Accessories  Force gauge

Procedure 1. Select and start the program EG_RECAL_F.

2. Follow the dialog messages and note the values of the 5 measurements.

If the measured force is significantly higher than the se-
lected force, cancel the program without performing any 

further measurements, and carry out calibration with EG_CAL. This also ap-
plies to the following steps. Further measurements may cause damage to 
property. 

During calibration, the gun closes at process velocity, not 
at test velocity.
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3. After the 5th measurement, take the force gauge out of the gun.

4. The gun moves to the mastering position and stops there. Carry out a vi-
sual check that the mastering position is correct.

 If it is: continue with the next step.

 If not: remaster the gripper. Then repeat the entire calibration.

5. Execute the program through to the end.

6. The values noted must be entered on the Force control configuration 
screen in Force 1 in kN to Force 5 in kN.

7. Click on Calculate, then save.

8. Test the obtained force values with the program EG_FORCE_F.

6.11 Setting the software limit switches

The positive and negative software limit switches for the gun (external axis) 
must be set. This limits the stroke of the gun.

6.11.1 Setting the negative software limit switch

Precondition  “Expert” user group

 The gun is mastered.

 The gear ratio has been entered.

 The gun is calibrated.

 New electrode tips

Procedure 1. Determine the value for the negative software limit switch:

a. Open the gun until it is almost completely open.

b. In the main menu, select Display > Variable > Overview > Display. 
Note the value of the Position variable.

c. Value sought = value of Position variable + reserve (recommended: 
height of 2 motor revolutions)

2. Enter this value in the Gun parameters configuration screen under Soft-
ware limit (mm) and save.

Alternative 

procedure

1. Take the value from the gun data sheet, and enter and save it in the Gun 
parameters configuration screen under Software limit (mm).

2. Check that the value is correct.

 To do this, open the gun manually and observe whether it stops auto-
matically at the point corresponding to the entered value, before 
reaching the stop.

 If the gun does not stop automatically, stop manual motion before the 
stop is reached. The value from the data sheet is not correct. The pos-
itive limit switch must be determined as described in the first proce-
dure.

If the force gauge is not removed from the gun, this may 
result in damage to property.

If the deviation between the setpoint and actual force is still too great 
after fine calibration with EG_RECAL_F, execute the program 
EG_RECAL_F again.

Do not open the gun all the way. If in doubt, stop a little 
earlier. Damage to property may otherwise result.
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6 Start-up and configuration
6.11.2 Setting the positive software limit switch

Precondition  “Expert” user group

 The gun is mastered.

 The gear ratio has been entered.

 The gun is calibrated.

 New electrode tips

Procedure 1. Calculate the value for the positive software limit switch:

Max. flexion (mm) + Tip wear (burn-off) + reserve (approx. 3 mm)

The values can be taken from the following sources:

 Max. flexion (mm): configuration screen Gun parameters

 Tip wear (burn-off): configuration screen Configuration

 Reserve: This value can be chosen freely as required. Guide value: 
3 mm

2. Enter the calculated value in the Gun parameters configuration screen 
under Software limit (mm) and save.

6.12 Checking the residual travel and software limit switches

To prevent mechanical damage to the spindle, the residual travel and software 
limit switches must be checked.

6.12.1 Dimensions and distances on a C gun

Fig. 6-7: Dimensions and distances on a C gun

1 Hardware stop

2 Negative software limit switch

3 Mastering position

4 Positive software limit switch
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6.12.2 Checking the residual travel and software limit switches for C guns

Precondition  The gun is mastered.

 The gun is calibrated.

 The pos. and neg. software limit switches have been configured.

 New electrode tips

Procedure 1. Calculate the residual travel between the positive software limit switch and 
the hardware stop using the following formula:

Residual travel = Total spindle travel – (positive software limit switch + 
maximum opening width specified by gun manufacturer + negative soft-
ware limit switch) 

2. Calculate the reserve distance using the following formula:

Reserve distance = positive software limit switch + residual travel after 
positive software limit switch 

3. Calculate the spindle opening using the following formula:

Spindle opening = Total spindle travel – reserve distance 

4. Move the weld gun to the mastering position.

5. Measure the spindle opening on the weld gun motor.

5 Hardware stop

A Residual travel before negative software limit switch (min. 1 
revolution of the motor)

B Maximum opening width of the gun

C Maximum tip burn-off (sum of the tip burn-off for both elec-
trodes)

D Maximum gun flexion

E 3 mm reserve

F Residual travel before positive software limit switch (min. 2 rev-
olutions of the motor)

G Reserve distance

H Complete spindle travel

Result Activity

Residual travel ≥ 2 revolutions of 
the motor

----------

Residual travel < 2 revolutions of 
the motor

Reduce the maximum tip burn-off in 
the configuration plug-in so that the 
residual travel = 2 motor revolu-
tions.
Issued: 10.04.2012 Version: KST ServoGun FC 2.0 V4 en



6 Start-up and configuration
6. Move the weld gun to the negative software limit switch.

7. Measure the spindle opening on the weld gun motor.

Fig. 6-8: Spindle opening of an extended C gun motor

Result Activity

Measured spindle opening > calcu-
lated spindle opening

Reduce the maximum tip burn-off in 
the configuration plug-in so that the 
measured spindle opening is no 
greater than the calculated spindle 
opening.

Measured spindle opening ≤ calcu-
lated spindle opening

----------
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6.12.3 Checking the residual travel and software limit switches for X guns

Precondition  The gun is mastered.

 The gun is calibrated.

 The pos. and neg. software limit switches have been configured.

 The minimum and maximum spindle dimension of the X gun motor are 
known.

 New electrode tips

The minimum or maximum spindle dimension is the distance between the mo-
tor flange and the outer surface of the eye when the motor is at the hardware 
stop.

Fig. 6-9: Spindle opening of a retracted C gun motor

Result Activity

Spindle opening ≥ 1 revolution of 
the motor

----------

Spindle opening < 1 revolution of 
the motor

Reduce the maximum opening in 
the configuration plug-in so that the 
spindle opening = 1 motor revolu-
tion.
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6 Start-up and configuration
Procedure 1. Check the gear ratio:

 Open the gun until the distance between the electrodes is exactly 
10 mm. (Measure the distance.)

 In the main menu, select Display > Actual position > Axis-specific. 
The gun opening width is displayed in the column Pos. [deg, mm].

 Compare the measured value with the value displayed.

 If the displayed value deviates by more than ±0.2 mm from the mea-
sured value, the gear ratio must be determined again.

2. Calculate the gear ratio using the following formula:

Gear ratio = change in the opening width over 1 motor revolution / spindle 
screw pitch

3. Convert the positive software limit switch to the spindle using the following 
formula:

Positive software limit switch on the spindle = value for positive software 
limit switch / gear ratio

4. Calculate the reserve distance using the following formula:

Reserve distance = positive software limit switch on the spindle + residual 
travel (2 revolutions of the motor)

5. Calculate the spindle dimension in the mastering position using the follow-
ing formula:

Spindle dimension in the mastering position = maximum spindle dimen-
sion – reserve distance

6. Move the gun to the mastering position and measure the spindle dimen-
sion on the motor.

7. If the measured spindle dimension is larger than the calculated spindle di-
menstion in the mastering position, then the maximum tip burn-off must be 
reduced.

8. Move the gun to the negative software limit switch and measure the spin-
dle dimension on the motor.

Fig. 6-10: Spindle dimensions on the X gun motor

1 Minimum spindle dimension of the X gun motor

2 Maximum spindle dimension of the X gun motor

The measured spindle dimension must not be larger than the calcu-
lated spindle dimension in the mastering position.
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6.13 Tip initialization – overview

Description During tip initialization, the current electrode burn-off is measured and saved. 
This enables the TCP and the gun opening to be automatically adapted to the 
burn-off.

There are 2 types of tip initialization:

 First initialization

Must be carried out in the following cases:

 During commissioning

 Every time the electrode tips are exchanged

 Cyclical initialization

Cyclical initialization must be carried out after tip dressing.

Overview Initialization can be performed using a status key or via a KRL program.

 First initialization

Via status key:  (>>> 6.13.1 "First initialization via status key" Page 50)

Via KRL:  (>>> 7.5.1 "Programming first initialization" Page 61)

 Cyclical initialization

Via status key:  (>>> 6.13.2 "Cyclical initialization via status key" Page 51)

Via KRL:  (>>> 7.5.2 "Programming cyclical initialization" Page 62)

6.13.1 First initialization via status key

Precondition  T1 or T2 operating mode

 The gun is mastered.

 The gun is calibrated.

 New electrode tips are fitted on the gun.

 The value First Init force has been entered and saved in the configuration 
screen Configuration.

Procedure 1. Set program override to 100%.

2. Open the gun manually at least 10 mm.

3. Hold down the enabling switch.

4. Press the status key First initialization. First initialization is performed:

Sequence With this first initialization, the following occurs:

 The gun closes at a constant velocity until the first initialization force is 
reached. The electrode tips are pressed firmly onto the electrodes.

Result Activity

Measured spindle dimension ≥ min-
imum spindle dimension + 1 motor 
revolution

----------

Measured spindle dimension < min-
imum spindle dimension + 1 motor 
revolution

Reduce the maximum opening in 
the configuration plug-in so that the 
measured spindle dimension = min-
imum spindle dimension + 1 motor 
revolution.

The gun opening is adapted to the current burn-off if the parameter 
TCP correction is set to On in the configuration screen Configura-
tion.
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6 Start-up and configuration
 The gun opens.

 The gun closes twice with initialization force.

 The robot controller saves the current tip wear in EG_WEAR[]. The vari-
able EG_WORN is set to FALSE. The output New electrodes is set and 
reset.

6.13.2 Cyclical initialization via status key

Precondition  T1 or T2 operating mode

 The gun is mastered.

 The gun is calibrated.

 First initialization has been performed.

Procedure 1. Set program override to 100%.

2. Open the gun manually at least 10 mm.

3. Hold down the enabling switch.

4. Press the Cyclical initialization status key. Cyclical initialization is carried 
out.

Sequence With this cyclical initialization, the following occurs:

 The gun closes twice with initialization force.

 The robot controller saves the current tip wear in EG_WEAR[]. It gener-
ates a message if the current wear is greater than the maximum permissi-
ble wear (EG_WEAR_MAX). The electrode tips must then be exchanged.

6.14 Controller parameters – overview

Description The controller tool can be used to determine and optimize the motor-specific 
and gun-specific controller parameters for PTP and CP motions. In addition, 
the proportional factor for the force controller can be determined.

The parameters must be determined in the following order:

Sequence The controller tool calls up programs which execute a defined motion profile 
cyclically with the active weld gun. At each program cycle, the parameter is in-
creased by the defined increment (‘step size’), starting from the lower limit and 
continuing until the upper limit is reached. The entire sequence for a parame-
ter is recorded as a measurement curve (trace).

While the parameters for the position and speed controllers are being deter-
mined, the axis of the active gun moves between a position before the nega-
tive software limit switch and the mastering position.

Step Parameter / description

1 Proportional factor of the speed controller for PTP and CP 
motions

VEL GAIN (Speed controller gain)

2 Integration time constant of the speed controller for PTP and 
CP motions

VEL INT TIME (Reset time of speed controller)

3 Position control gain for PTP and CP motions

POS GAIN (Position controller gain)

4 Proportional factor for force controller

FORCE GAIN (Force controller gain)
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While the parameter for the force controller is being determined, the measure-
ment curve is recorded at 3 different forces for each value of FORCE GAIN. 
The precise value of FORCE GAIN is determined in 2 program cycles.

Servo Gun 

parameter finding

The following buttons are available:

Fig. 6-11: Window: Servo Gun parameter finding

1 Table

2 Enter the determined parameters here.

Button Description

Motor param. Selects the program 
EG_SET_MOTOR_PARAM. This program is 
used to determine the parameters for the speed 
and position controllers.

Force parameter Selects the program EG_SET_FORCE_PARAM. 
This program is used to determine the parame-
ters for the force controller.

Trace > 
[controller_parameter]

Only available to the user group “Expert” or 
higher.

Opens the measurement curve for the selected 
parameter.
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6 Start-up and configuration
6.14.1 Optimizing the parameters for the speed and position controllers

Precondition  The weld gun is fully configured.

 The software limit switches have been set.

 The weld gun is mastered.

 The gun has been calibrated.

 The gear ratio has been entered.

 Operating mode T2

Procedure 1. In the main menu, select Configuration > ServoGun controller param.. 
The Servo Gun parameter finding window is opened.

2. Fill out the following boxes: Gun number:, Motor type, Gun type and 
Stiffness.

3. Fill out the following boxes: Lower limit, Upper limit and Steps. (Not nec-
essary for the parameter FORCE GAIN.)

4. Press the Motor param. button. The program EG_SET_MOTOR_PARAM 
is selected.

5. Set program override to 100% and execute the program up to the first 
HALT.

6. In the main menu, select Configuration > ServoGun controller param..

7. Select the menu sequence Trace > VEL GAIN. The measurement curve 
for VEL GAIN opens.

8. Read and note the value of VEL GAIN from the measurement curve. 
(VEL GAIN = half the value at which the motor current begins to oscillate.)

9. Close the measurement curve and enter the determined value in the Ser-
vo Gun parameter finding in the following box: VEL GAIN (Speed con-
troller gain). Then click on Save values.

10. Close the Servo Gun parameter finding window and execute the select-
ed program until the next HALT.

11. In the main menu, select Configuration > ServoGun controller param..

12. Select the menu sequence Trace > VEL INT TIME. The measurement 
curve for VEL INT TIME opens.

Table > Load table Only available to the user group “Expert” or 
higher.

Loads the default values for the following param-
eters: Lower limit, Upper limit, Steps

The default values depend on what is selected in 
the following boxes: Motor type, Gun type, 
Stiffness

Table > Discard table Only available to the user group “Expert” or 
higher.

Discards the current entries in the following 
boxes: Lower limit, Upper limit, Steps. Instead, 
the most recently saved values are displayed.

Save table Saves the following values: Lower limit, Upper 
limit, Steps

Save values Saves the entered values.

Button Description

If the program override is not set to 100%, the measurements will be 
incorrect.
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13. Read and note the value of VEL INT TIME from the measurement curve. 
(VEL INT TIME = value with the smallest following error at standstill.)

14. Close the measurement curve and enter the determined value in the Ser-
vo Gun parameter finding in the following box: VEL INT TIME (Reset 
time of speed controller). Then click on Save values.

15. Close the Servo Gun parameter finding window and execute the select-
ed program until the next HALT.

16. In the main menu, select Configuration > ServoGun controller param..

17. Select the menu sequence Trace > POS GAIN. The measurement curve 
for POS GAIN opens.

18. Read and note the value of POS GAIN from the measurement curve. 
(POS GAIN = half the value at which the motor current begins to oscillate.)

19. Close the measurement curve and enter the determined value in the Ser-
vo Gun parameter finding in the following box: POS GAIN (Position 
controller gain). Then click on Save values.

20. Close the Servo Gun parameter finding window and execute the select-
ed program through to the end.

The PTP parameters are automatically saved in addition as CP parame-
ters.

6.14.2 Optimizing the parameters for the force controller

Description The proportional factor for the force controller FORCE_GAIN is determined in 
2 program cycles, in order to obtain a value that is as precise as possible. In 
the first cycle, FORCE_GAIN is determined approximately, and in the second 
cycle the precise value is determined using a smaller increment.

Precondition  The weld gun is fully configured.

 The software limit switches have been set.

 The weld gun is mastered.

 The gun has been calibrated.

 The gear ratio has been entered.

 Operating mode T2

 The parameters for the speed and position controllers have been deter-
mined.

Procedure 1. In the main menu, select Configuration > ServoGun controller param.. 
The Servo Gun parameter finding window is opened.

2. Fill out the following boxes: Gun number:, Motor type, Gun type and 
Stiffness.

3. In the FORCE GAIN line, fill out the following boxes: Lower limit, Upper 
limit and Steps.

4. Press the Force parameter button. The program 
EG_SET_FORCE_PARAM is selected.

5. Set program override to 100% and execute the program up to the first 
HALT.

6. In the main menu, select Configuration > ServoGun controller param..

7. Select the menu sequence Trace > FORCE GAIN. The measurement 
curve for FORCE GAIN opens.

8. Read and note the value of FORCE GAIN from the measurement curve. 
(FORCE GAIN = value with the best velocity and the smallest overshoot.)

If the program override is not set to 100%, the measurements will be 
incorrect.
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6 Start-up and configuration
9. Close the measurement curve and enter the determined value in the Ser-
vo Gun parameter finding in the following box: FORCE GAIN (Force 
controller gain). Then click on Save values.

10. In the Servo Gun parameter finding window, reduce the lower limit, up-
per limit and step size, in order to limit the search range.

11. Click on Save table.

12. Close the Servo Gun parameter finding window and execute the select-
ed program until the next HALT.

13. In the main menu, select Configuration > ServoGun controller param..

14. Select the menu sequence Trace > FORCE GAIN FINE. The measure-
ment curve for FORCE GAIN FINE opens.

15. Read and note the value of FORCE GAIN FINE from the measurement 
curve. (FORCE GAIN FINE = value with the best velocity and the smallest 
overshoot.)

16. Close the measurement curve and enter the determined value in the Ser-
vo Gun parameter finding in the following box: FORCE GAIN (Force 
controller gain). Then click on Save values.

17.  Close the Servo Gun parameter finding window and execute the select-
ed program through to the end.

The PTP parameters are automatically saved in addition as CP parame-
ters.
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7 Programming
7 Programming

7.1 Inline forms – overview

7.2 Instructions

7.2.1 Instructions for use of stationary guns

The descriptions regarding programming refer to guns mounted on the robot 
flange. For stationary guns, the programming must be adapted accordingly.

Aspects requiring special consideration: 

 In the option window Frames the interpolation mode must be set to True, 
indicating that a stationary gun is being used. This concerns the following 
inline forms:

 SPOT

 TippDress

 While tip dressing or initialization is being carried out with a stationary gun, 
the robot is not available for other work (e.g. fetching a new workpiece).

Reason: Robot axes and an external axis (= gun) are moved synchronous-
ly. This means they perform common motions that start and finish simulta-

Inline form Description

SPOT Programming a weld spot with/without EqualizingTech

 (>>> 7.3 "Programming a weld spot" Page 58)

 (>>> 7.4 "Programming a weld spot with EqualizingTech" 
Page 59)

INIT Measuring and saving the current wear

 (>>> 7.5.1 "Programming first initialization" Page 61)

 (>>> 7.5.2 "Programming cyclical initialization" Page 62)

TippDress Tip dressing with/without EqualizingTech

 (>>> 7.6 "Programming tip dressing" Page 63)

 (>>> 7.7 "Programming tip dressing with EqualizingTech" 
Page 66)

ServoGun Decouple Decoupling the gun

 (>>> 7.8 "Inline form ServoGun Decouple" Page 68)

ServoGun Couple Coupling the gun

 (>>> 7.9 "Inline form ServoGun Couple" Page 68)

Recommendation: Do not weld in T1 mode. In T1, the velocity is lim-
ited: force build-up takes a long time and can therefore trigger moni-
toring functions.

Weld spots and tip dressing points that were taught with-
out EqualizingTech having been installed, must not be 

used with EqualizingTech.
Weld spots and tip dressing points that were taught with EqualizingTech 
must not be used without EqualizingTech. 
The points must be retaught. Damage to the gun or the workpiece may oth-
erwise result.
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neously. Even though the robot axes are usually stationary during 
dressing and initialization, this is nevertheless part of the overall motion. 
The robot axes are therefore not able to execute other movements inde-
pendently of the external axis.

7.3 Programming a weld spot

Distances The following distances are required for the position of the gun during teach-
ing:

Procedure 1. Position the gun on the desired weld spot. Observe the required distances.

2. Select the menu sequence Commands > ServoTech > SPOT and then 
select the desired motion type.

3. Set the parameters in the inline form.

 (>>> 7.3.1 "Inline form “SPOT”" Page 58)

4. Press Cmd OK to save the instruction.

7.3.1 Inline form “SPOT”

The instruction performs a motion and executes a weld spot at the end point.

This description refers to ServoGun without EqualizingTech. If Equal-
izingTech is installed, the relevant description must be used:  
(>>> 7.4 "Programming a weld spot with EqualizingTech" Page 59)

Distance … Value

Moving electrode Min. 15 mm distance from the workpiece

Fixed electrode Max. 5 mm distance from the workpiece

Gun opening Must be at least 4 mm less than the nega-
tive software limit switch.

Fig. 7-1: Inline form: SPOT with CIRC, point selection

Item Description

1 Type of motion

 PTP, LIN or CIRC

2 Only for CIRC motions: Auxiliary point

3 The point index (7 figures) is communicated to the weld timer as 
the program number. 

Observe all 7 places including leading zeros!

 1 … 9 999 999

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 7.10 "Option window “Frames”" Page 69)
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7.4 Programming a weld spot with EqualizingTech

Distances The following distances are required for the position of the gun during teach-
ing:

Procedure 1. Position the gun on the desired weld spot. Observe the required distances.

2. Select the menu sequence Commands > ServoTech > SPOT and then 
select the desired motion type.

3. Set the parameters in the inline form.  (>>> 7.4.1 "Inline form “SPOT” 
(EqualizingTech)" Page 60)

4. Press Cmd OK to save the instruction.

4 Velocity

 For PTP: 0 … 100 %

 For LIN or CIRC: 0.001 … 2 m/s

5 Name for the motion data set

The system automatically generates a name. The name can be 
overwritten. Touch the arrow to edit the point data. The corre-
sponding option window is opened.

 (>>> 7.11 "Option window: Motion parameters (PTP)" Page 70)

 (>>> 7.12 "Option window: Motion parameters (LIN, CIRC)" 
Page 70)

6 Active gun

 1 … 6

7  CLS OPN: Approximate positioning during closing and open-
ing motions

 OPN: Approximate positioning during opening motion

 CLS: Approximate positioning during closing motion

 (blank): Without approximate positioning

8 Total thickness of the workpieces to be welded

 0 … 100 mm

9 Welding force

 Switch-on threshold … 10 kN

10  0: Without compensation

 1: Compensator 1

 2: Compensator 2

11 Distance after which compensation is deactivated on opening the 
gun.

The point index is incremented automatically.

Changing the gun number also changes the point name. A new 
point is created.

Item Description

Distance … Value

Fixed electrode No distance from the workpiece; must be 
in contact with the workpiece.

Gun opening Must be at least 4 mm away from the neg-
ative software limit switch.
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Sequence Program sequence for welding:

When approaching points, the robot maintains a certain distance from the 
workpiece so that the fixed electrode does not scrape against the workpiece. 
The user can configure this distance (for all weld spots for the gun) via the 
REAL variable EG_TOUCH_DIFF[] in the file EG_EXTERN.DAT. Default set-
ting: 3 mm.

The actual opening width of the gun at the point is the sum of the taught open-
ing width and this distance. 

7.4.1 Inline form “SPOT” (EqualizingTech)

Fig. 7-2: SPOT (EqualizingTech), Point name

Fig. 7-3: SPOT (EqualizingTech), Program number

Item Description

1 Motion type

 PTP, LIN or CIRC

2 Only for CIRC motions: Auxiliary point

3 For the Point name option: 

Name of the end point. The last 7 characters (= default number) 
must be digits. The robot controller communicates these digits to 
the weld timer as the program number.

 […]0 000 001… […]9 999 999

The number of relevant final characters can be configured in 
WorkVisual.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 7.10 "Option window “Frames”" Page 69)

4 Velocity

 For PTP: 0 … 100 %

 For LIN or CIRC: 0.001 … 2 m/s
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7.5 Programming tip initialization

Overview Initialization can be performed using a status key or via a KRL program.

 First initialization

Via status key:  (>>> 6.13.1 "First initialization via status key" Page 50)

Via KRL:  (>>> 7.5.1 "Programming first initialization" Page 61)

 Cyclical initialization

Via status key:  (>>> 6.13.2 "Cyclical initialization via status key" Page 51)

Via KRL:  (>>> 7.5.2 "Programming cyclical initialization" Page 62)

7.5.1 Programming first initialization

Description 1 position must be taught for initialization. This is taught as a normal motion 
point. 

Precondition  T1 or T2 operating mode

 The gun has been calibrated as a tool. This tool is currently selected.

 The gun is mastered.

 The gun is calibrated.

5 Name for the motion data set

The system automatically generates a name. The name can be 
overwritten. Touch the arrow to edit the point data. The corre-
sponding option window is opened.

 (>>> 7.11 "Option window: Motion parameters (PTP)" Page 70)

 (>>> 7.12 "Option window: Motion parameters (LIN, CIRC)" 
Page 70)

6 Active gun

 1 … 6

7  CLS OPN: Approximate positioning during closing and open-
ing motions

 OPN: Approximate positioning during opening motion

 CLS: Approximate positioning during closing motion

 [blank]: Without approximate positioning

8 Total thickness of the workpieces to be welded

 0 … 100 mm

9 Closing force of the gun

 Maximum value: Value of the configuration parameter Maxi-
mum gun force in kN

Note: If the option Force from Timer was selected, this box is not 
shown. 

10 With the Program number option: Name of the end point

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 7.10 "Option window “Frames”" Page 69)

11 With the Program number option: Program number for the weld 
timer

 1 … 100 000

Item Description
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 New electrode tips are fitted on the gun.

 The following values have been entered and saved in the configuration 
screen Configuration: First Init force, TCP orientation

 The software limit switches have been set.

Procedure 1. Move the gun to the position at which initialization is to be performed.

The position must be at least 4 mm away from the negative software limit 
switch.

2. Teach a conventional PTP, LIN or CIRC point at this position.

3. Select the menu sequence Commands > ServoTech > INIT.

4. Select the gun in the inline form. 

5. Select New in the inline form.

 (>>> 7.5.3 "Inline form “INIT”" Page 63)

6. Press Cmd OK to save the instruction.

Sequence With this first initialization, the following occurs:

 The gun closes at a constant velocity until the first initialization force is 
reached. The electrode tips are pressed firmly onto the electrodes.

 The gun opens.

 The gun closes twice with initialization force.

 The robot controller saves the current tip wear in EG_WEAR[].

 The gun moves to the initialization position.

 The moving gun arm performs a motion with initialization force.

 The variable EG_WORN is set to FALSE. The output New electrodes is 
set and reset. 

7.5.2 Programming cyclical initialization

Description 1 position must be taught for initialization. This is taught as a normal motion 
point. 

Precondition  T1 or T2 operating mode

 The gun has been calibrated as a tool. This tool is currently selected.

 The gun is mastered.

 The gun is calibrated.

 The software limit switches have been set.

 First initialization has been performed.

Procedure 1. Move the gun to the position at which initialization is to be performed.

The position must be at least 4 mm away from the negative software limit 
switch.

2. Teach a conventional PTP, LIN or CIRC point at this position.

3. Select the menu sequence Commands > ServoTech > INIT.

4. Select the gun in the inline form.

5. Select Same in the inline form.

 (>>> 7.5.3 "Inline form “INIT”" Page 63)

6. Press Cmd OK to save the instruction.

Sequence With this cyclical initialization, the following occurs:

 The gun closes twice with initialization force.

 The robot controller saves the current tip wear in EG_WEAR[]. It gener-
ates a message if the current wear is greater than the maximum permissi-
ble wear (EG_WEAR_MAX). The electrode tips must then be exchanged.
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7.5.3 Inline form “INIT”

This instruction is used for initializing the tips.

7.6 Programming tip dressing

Description TipDress executes a weld spot without approximate positioning.

The default sequence for tip dressing corresponds to the sequence for weld-
ing: the robot controller sends the point index to the weld timer and the gun 
closes until the force programmed in the inline form is reached. Once the force 
is reached, the robot controller sets the output Weld start and waits for the in-
put Weld end.

If a different sequence is required for tip dressing, this can be programmed in 
the subprogram EG_USERDRESS. In order for the robot controller to perform 
this different sequence, the variable EG_NON_KUKA_DRESS must be set to 
TRUE.

The inline form does not contain any position data; the preceding 
point is used. The point must be at least 4 mm away from the negative 
software limit switch.

Fig. 7-4: Inline form: INIT

Item Description

1 Select the active gun.

 1 … 6

2  New: First initialization

 Same: Cyclical initialization

This description refers to ServoGun without EqualizingTech. If Equal-
izingTech is installed, the relevant description must be used:  
(>>> 7.4 "Programming a weld spot with EqualizingTech" Page 59)

Dressing must be performed without weld current. This 
must be set in the weld timer. If dressing is carried out 

with weld current, damage to property is liable to occur.
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Distances The following distances are required for the position of the gun during teach-
ing:

Precondition  The thickness of the tip dresser has been determined.

 (>>> 7.6.1 "Determining the thickness of the tip dresser" Page 64)

Procedure 1. Position the gun on the desired tip dressing point. Observe the required 
distances.

2. Select the menu sequence Commands > ServoTech > TippDress and 
then select the desired motion type.

3. Set the parameters in the inline form. Also enter the thickness of the tip 
dresser.

 (>>> 7.6.2 "Inline form “TippDress”" Page 65)

4. Press Cmd OK to save the instruction.

7.6.1 Determining the thickness of the tip dresser

Description The thickness of the tip dresser is required for the inline form TippDress.

Precondition  The gun is mastered.

 New electrode tips are fitted on the gun.

 T1 or T2 operating mode

Procedure 1. Position the gun with both electrodes on the the tip dresser.

Fig. 7-5: Tip dressing

Distance … Value

Moving electrode Min. 15 mm distance from the workpiece

Fixed electrode Max. 5 mm distance from the workpiece

Gun opening Must be at least 4 mm less than the nega-
tive software limit switch.

After tip dressing, cyclical initialization must be performed.
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2. Close the gun until build-up of tip dressing force.

3. In the main menu, select Display > Variable > Overview > Display.

4. Read and note the value of the Position variable.

7.6.2 Inline form “TippDress”

This instruction dresses the electrode tips. 

The following parameters must be set in the weld timer:

 Dressing time (complete cycle time)

 Cycle without current

Fig. 7-6: Inline form: TippDress with PTP, point selection

Item Description

1 Type of motion

 PTP or LIN

2 The point index (7 figures) is communicated to the weld timer as 
the program number. 

Observe all 7 places including leading zeros!

 1 … 9 999 999

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 7.10 "Option window “Frames”" Page 69)

3 Velocity

 1 … 100 %

4 Name for the motion data set

The system automatically generates a name. The name can be 
overwritten. Touch the arrow to edit the point data. The corre-
sponding option window is opened.

 (>>> 7.11 "Option window: Motion parameters (PTP)" Page 70)

 (>>> 7.12 "Option window: Motion parameters (LIN, CIRC)" 
Page 70)

5 Active gun

 1 … 6

6 Thickness of the tip dresser

 1 … 100 mm

7 Closing force of the gun

 0.75 … 10 kN
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7.7 Programming tip dressing with EqualizingTech

Description TippDress executes a weld spot without approximate positioning.

The following parameters must be set in the weld timer:

 Dressing time (complete cycle time)

 Cycle without current

Distances The following distances are required for the position of the gun during teach-
ing:

Precondition  The thickness of the tip dresser has been determined.

 (>>> 7.6.1 "Determining the thickness of the tip dresser" Page 64)

Procedure 1. Position the gun on the desired tip dressing point. Observe the required 
distances.

2. Select the menu sequence Commands > ServoTech > TippDress > Ser-
voTech or LIN.

3. Set the parameters in the inline form. Also enter the thickness of the tip 
dresser.  (>>> 7.7.1 "Inline form “TippDress” (EqualizingTech)" Page 67)

4. Press Cmd OK to save the instruction.

Sequence Program sequence for tip dressing:

The default sequence corresponds to the sequence for welding. 

If a different sequence is required for tip dressing, this can be programmed in 
the subprogram EG_USERDRESS. In order for the robot controller to perform 
this different sequence, the variable EG_NON_KUKA_DRESS must be set to 
TRUE.

8  0: Without compensation

 1: Compensator 1

 2: Compensator 2

9 Distance after which compensation is deactivated on opening the 
gun.

The point index is incremented automatically.

Changing the gun number also changes the point name. A new 
point is created.

Item Description

Dressing must be performed without weld current. If 
dressing is carried out with weld current, damage to 

property is liable to occur.

Distance … Value

Fixed electrode No distance from the workpiece; must be 
in contact with the workpiece.

Gun opening Must be at least 4 mm away from the neg-
ative software limit switch.

After tip dressing, cyclical initialization must be performed.
Issued: 10.04.2012 Version: KST ServoGun FC 2.0 V4 en



7 Programming
7.7.1 Inline form “TippDress” (EqualizingTech)

Fig. 7-7: TippDress (EqualizingTech), Point name

Fig. 7-8: TippDress (EqualizingTech), Program number

Item Description

1 Motion type

 PTP or LIN

2 With the Point name option: 

Name of the end point. The last 7 characters (= default number) 
must be digits. The robot controller communicates these digits to 
the weld timer as the program number.

 […]0 000 001… […]9 999 999

The number of relevant final characters can be configured in 
WorkVisual.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 7.10 "Option window “Frames”" Page 69)

3 Velocity

 For PTP: 0 … 100 %

 For LIN or CIRC: 0.001 … 2 m/s

4 Name for the motion data set

The system automatically generates a name. The name can be 
overwritten. Touch the arrow to edit the point data. The corre-
sponding option window is opened.

 (>>> 7.11 "Option window: Motion parameters (PTP)" Page 70)

 (>>> 7.12 "Option window: Motion parameters (LIN, CIRC)" 
Page 70)

5 Active gun

 1 … 6

6 Thickness of the tip dresser

 0 … 100 mm
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7.8 Inline form ServoGun Decouple

Description This command decouples – within the software – the gun currently in use. The 
inline form does not control any hardware, inputs or outputs.

7.9 Inline form ServoGun Couple

Description This command couples – within the software – the gun currently in use. The 
inline form does not control any hardware, inputs or outputs.

7 Closing force of the gun

 Maximum value: Value of the configuration parameter Maxi-
mum gun force in kN

Note: If the option Force from timer was selected, this box is not 
shown. 

8 With the Program number option: Name of the end point

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 7.10 "Option window “Frames”" Page 69)

9 With the Program number option: Program number for the weld 
timer

 1 … 100 000

Item Description

The opening width of the gun must be identical in both the coupling 
and decoupling position. Recommendation: The gun should be 
open at least 10 mm.

Do not decouple the gun if it is in the mastering position, since the mastering 
would otherwise be lost when the gun is recoupled.

Fig. 7-9

Item Description

1 Select the active gun.

 1 ... 6

The opening width of the gun must be identical in both the coupling 
and decoupling position. Recommendation: The gun should be 
open at least 10 mm.

Fig. 7-10
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7.10 Option window “Frames”

Item Description

1 Select the active gun.

 1 ... 6

Fig. 7-11: Option window: Frames

Item Description

1 Tool selection.

If True in the box External TCP: workpiece selection.

Range of values: [1] … [16]

2 Base selection.

If True in the box External TCP: fixed tool selection.

Range of values: [1] … [32]

3 Interpolation mode

 False: The tool is mounted on the mounting flange.

 True: The tool is a fixed tool.

4  True: For this motion, the robot controller calculates the axis 
torques. These are required for collision detection.

 False: For this motion, the robot controller does not calculate 
the axis torques. Collision detection is thus not possible for this 
motion.
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7.11 Option window: Motion parameters (PTP)

7.12 Option window: Motion parameters (LIN, CIRC)

Fig. 7-12: Option window: Motion parameters (PTP)

Item Description

1 Acceleration

Refers to the maximum value specified in the machine data. The 
maximum value depends on the robot type and the selected oper-
ating mode.

 1 … 100 %

2 This box is only displayed if it is specified in the inline form that the 
point is to be approximated.

Furthest distance before the end point at which approximate posi-
tioning can begin.

Maximum distance 100%: half the distance between the start 
point and the end point relative to the contour of the PTP motion 
without approximate positioning

 1 … 100 %

Fig. 7-13: Option window: Motion parameters (LIN, CIRC)
Issued: 10.04.2012 Version: KST ServoGun FC 2.0 V4 en



7 Programming
7.13 Adaptable subprograms

The following subprograms can be adapted to the specific requirements by the 
user.

The subprograms can be found here:

 In the directory R1\TP\ServoGun_FC in the file EG_User.SRC

Precondition  “Expert” user group

Subprograms

Inputs/outputs can be set in the subprograms. This triggers exact positioning.

Item Description

1 Acceleration

Refers to the maximum value specified in the machine data. The 
maximum value depends on the robot type and the selected oper-
ating mode.

2 This box is only displayed if it is specified in the inline form that the 
point is to be approximated.

Furthest distance before the end point at which approximate posi-
tioning can begin

The maximum permissible value is half the distance between the 
start point and the end point. If a higher value is entered, this is 
ignored and the maximum value is used.

3 Orientation control selection.

 Standard

 Wrist PTP

 Constant orientation control

Subprogram Description

EG_PRE Called by the robot controller before each weld 
spot.

EG_POST Called by the robot controller after each weld 
spot.

EG_PRED Called by the robot controller before each tip 
dressing point.

EG_POSTD Called by the robot controller after each tip 
dressing point.

EG_USERDRESS If the default sequence is not desired for tip 
dressing, the user can program a different 
sequence here. In order for the robot controller 
to perform this different sequence, the variable 
EG_NON_KUKA_DRESS must be set to TRUE.
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8 Diagnosis

8.1 Carrying out tests

Precondition  Operating mode T2

 Program override 100%

 For Calibration test: The gun flexion has been determined.

 (>>> 8.3 "Determining the gun flexion (independently of the force sensor)" 
Page 75)

Procedure 1. Hold down the enabling switch.

2. Start the program EG_DIAGNOSE.

The robot controller performs all the tests and displays the relevant messages. 
A trace is generated for each test in the directory KRC:\Roboter\Trace.

If an error occurs during a test, the robot controller generates an error mes-
sage. The remaining tests are then no longer carried out.

 (>>> 8.2 "Description of the tests" Page 74)

Alternative 

procedure

This procedure can be used to perform the tests individually. It is suitable for 
users with experience in fault diagnosis.

Additional precondition: User group “Expert”

1. In the main menu, select Configuration > ServoGun Diagnosis.

The ServoGun Diagnosis Tool window is opened.

2. Select the number of the active gun in the Active gun number box.

3. Hold down the enabling switch.

4. Start the required test.

Description

There must be no object positioned between the elec-
trode tips, otherwise damage to property may result.

Fig. 8-1: ServoGun Diagnosis Tool window

Item Description

1 Select the active gun.

2 Descriptions of the tests
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8.2 Description of the tests

Reset test The sensor value is polled after sensor reset.

 Sensor value < 450: message The sensor reset works well

 Sensor value ≥ 450: message The sensor reset does not work. See "Reset" tra-
ce, channel 11/24

The name of the trace recording is RESET.

Noise test The test opens and closes the gun twice (5 mm from the negative software lim-
it switch to 5 mm from the gun mastering) and checks the sensor value. The 
tolerances are configured in the file EG_EXTERN.DAT using the variables 
EG_NOISE_TOL_P (positive direction) and EG_NOISE_TOL_N (negative di-
rection).

Default value for both directions: 50 incr.

 Value within tolerance: message The noise test was OK

 Value out of tolerance: message The noise test failed. See "Noise" trace, 
channel 11/24

The name of the trace recording is NOISE.

Mastering test The gun is checked in the mastering position to see if a force is out of toler-
ance. In addition, the user must check the mastering position visually.

The name of the trace recording is MASTER.

Procedure:

1. Start Mastering test.

The gun is closed to the mastering position. The message Check the gun 
mastering. Is it OK? is displayed.

2. Check the mastering position visually.

3. Answer the prompt with Yes or No. The gun opens.

The tolerance is configured in the file EG_EXTERN.DAT using the variable 
EG_MASTER_TOL_P. 

Default value: 100 N

 Value within tolerance: message The gun mastering is OK

 Value out of tolerance: message The gun mastering is not OK. See "Master" 
trace, channel 10/23

Calibration test Description:

The test closes the gun once to ¼ and once to ¾ of the maximum force, check-
ing in each position whether the force corresponds to the calibrated force. The 
tolerances are configured in the file EG_EXTERN.DAT using the variables 
EG_CALIB_TOL_P (positive direction) and EG_CALIB_TOL_N (negative di-
rection).

Default value for both directions: 100 N

 Value within tolerance: message The gun calibration is OK

 Value out of tolerance: message The gun calibration is not OK. See "Calib" tra-
ce, channel 10/23

3 LED icon showing the test status. If a test is running, the icon is 
green.

4 Click on a button to start the corresponding test. A trace recording 
is generated for each test.

Item Description
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The name of the trace recording is CALIB.

Welding test This test checks the constancy of the force value. The gun is closed to initial-
ization force for welding. The tolerances are configured in the file 
EG_EXTERN.DAT using the variables EG_WELDTEST_TOL_P (positive di-
rection) and EG_WELDTEST_TOL_N (negative direction).

Default value for both directions: 50 N

The test is only carried out if the configuration parameter Timer type is not set 
to TEST.

 Value within tolerance: message The welding test was OK

 Value out of tolerance: message The welding test failed. See "WeldTest" trace, 
channel 10/23

 No timer configured: message The welding test is not possible because the 
timer type is "test"

The name of the trace recording is WELD. 

8.3 Determining the gun flexion (independently of the force sensor)

Description The program EG_FLEXXX determines the gun flexion. Unlike with calibration, 
the gun flexion is determined independently of the flexion of the force sensor. 
This value is not needed for welding, but is required for the calibration test as 
part of diagnosis.

Precondition  Operating mode T2

 Program override 100%

 The gun is calibrated.

Precondition  Operating mode T2

 Program override 100%

Procedure 1. If a force sensor is still attached to the gun, this must be removed.

2. In the Navigator, start the program KRC:\R1\Program\EG_FLEXXX. 

3. Follow the messages.

The flexion is determined. The determined value is not displayed, but 
saved internally.

There must be no object positioned between the elec-
trode tips, otherwise damage to property may result.
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9 System variables

9.1 Important variables in EG_EXTERN.DAT

Variable Description

EG_COMPENSATE_DELAY INT

Distance after resetting compensation until settling of the 
gun position

Default value: 0 mm

EG_FORCE_INIT[1] ... [6] REAL

Initialization force 

Default value: 2.0 kN

EG_FORCE_INIT_NEW[1] ... [6] REAL

First initialization force

Default value: 3 kN

EG_INIT_TOL_N[1] ... [6] REAL

Negative position tolerance for initialization

Default value: -5 mm

EG_INIT_TOL_P[1] ... [6] REAL

Positive position tolerance for initialization

Default value: 5 mm

EG_NON_KUKA_DRESS BOOL

 FALSE (default): Default sequence for tip dressing

 TRUE: Use a user-defined program EG_USERDRESS 
for tip dressing

EG_OFFICE BOOL

Office mode

Default value: FALSE

EG_PART_CONTROL BOOL

Workpiece check

Default value: TRUE

EG_RESET_CHECK_VALUE REAL

Force check after sensor reset. If the value is < 1, the reset 
is accepted.

Default value: 1

EG_SERVOGUN_EXAXIS[1] ... 
[6]

INT

Assignment of a gun to an external axis

Default value: 0

EG_TIMEOUT[4] REAL

Timeout for different types of error messages 

Default value: (various)
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9.2 Important kernel system variables

EG_TOUCH_DIFF[1] ... [6] REAL

Only relevant if Equalizing is installed.

When approaching weld spots and tip dressing points, the 
robot maintains a certain distance from the workpiece so 
that the fixed electrode does not scrape against the work-
piece. The variable defines the distance. The opening width 
of the gun at the point is the sum of the taught opening 
width and the distance.

Default value: 3 mm

EG_WEAR[1] ... [6] REAL

Current electrode wear (both electrodes) 

Default value: 0 mm

EG_WEAR_MAX[1] ... [6] REAL

Maximum permissible electrode wear (both electrodes)

Default value: 8 mm

EG_WELD_DISTANCE [1] ... [6] REAL

Gun flexion calculated by EG_CAL

Default value: 20 mm

EG_WELD_TOL_N REAL

Negative position tolerance for the weld spot

Default value: -5 mm

EG_WELD_TOL_P REAL

Positive position tolerance for the weld spot

Default value: 5 mm

EG_WORN[1] ... [6] BOOL

Current electrode wear greater than max. permissible elec-
trode wear

Default value: FALSE

Variable Description

Variable Description

$FORCE_ACT[7]...[12] REAL

Actual force on the force sensor

Default value: 0 N
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10 Messages

10.1 Overview of error messages

The error messages of ServoGun FC are generated either by the kernel sys-
tem or by the technology package.

10.2 Error messages caused by the weld gun

Source of error message Error number Effect

Kernel system With error number In the case of an error mes-
sage from the kernel system, 
the weld gun remains in the 
actual position.

Technology package Without error number In the case of an error mes-
sage from the technology 
package under force control, 
the weld gun opens automati-
cally. The spot can be 
repeated or the next spot can 
be moved to.

Default value of the maximum 
weld time: 3 s

Message text Cause Remedy

The selected gun is not cali-
brated.

The selected weld gun has not 
yet been calibrated.

Calibrate the weld gun.

Gun cannot close. The gun could not be closed 
due to mechanical locking.

Eliminate mechanical locking.

Error during first initialization. 
Tip wear is out of tolerance.

Electrode tip missing. Fit new electrode tip.

Tips are not properly seated. Ensure that tips are fitted cor-
rectly.

Incorrect mastering, initializa-
tion or calibration.

Check start-up procedure.

Incorrect gun position. Initial-
ization, mastering, part thick-
ness?

Programmed sum of the work-
piece thicknesses is not cor-
rect.

Correct the value for the work-
piece thickness.

1 or more electrode tips are 
missing.

Fit missing electrode tip(s).

Gun does not close to the pro-
grammed thickness due to 
mechanical locking.

Check mechanical system of 
gun.

Incorrect mastering, initializa-
tion or gun flexion calibration.

Check start-up procedure.

The electrode burn-off is out 
of tolerance. Please check 
mastering and tip wear. 
Repeat initialization, Yes/No?

Electrode burn-off is outside 
the set maximum burn-off.

Incorrect mastering, initializa-
tion or gun flexion calibration.

 Fit new electrode tips.

 Ensure that tips are fitted 
correctly.

 Carry out first initialization.

Tip wear is out of tolerance. 
Please check the tip wear and 
the gun mastering. Do you 
want to proceed, Yes/No?

 Electrode burn-off is out-
side the set maximum 
burn-off. 

 Incorrect mastering, initial-
ization or gun flexion cali-
bration.

 Fit new electrode tips (cor-
rect length).

 Ensure that tips are fitted 
correctly.

 Carry out first initialization.
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10.3 Error messages caused by force control

Message text Cause Remedy

Programmed force not 
reached!

The workpiece thickness is 
lower than the programmed 
value.

Correct the value for the work-
piece thickness.

The maximum flexion value is 
too low.

Correct the maximum flexion 
value.

Error due to mechanical lock-
ing during force build-up.

Eliminate mechanical locking.

Command force is higher than 
maximum gun force

The welding force is higher 
than the maximum gun force.

 Reduce the welding force.

 Correct the maximum gun 
force.

Incorrect force or calibration  Open circuit at welding 
transformer

 Force = 0

  Force calibration values = 
0

 Desired force greater than 
maximum force

 Calibrate force.

 Check welding transform-
er and connecting cables.

 Set the force calibration 
values in ascending order 
greater than 0 and carry 
out force calibration again.

 Select a desired force that 
is less than or equal to the 
maximum force of the gun.

The target force is lower than 
the switch-on threshold for 
force control!

The welding force is lower 
than the switch-on threshold.

 Increase the welding force.

 Check the switch-on 
threshold.

Permitted maximum force 
exceeded

The upper monitoring limit 
was exceeded while the weld 
gun was under force control.

Possible causes:

 Value for FORCE_GAIN 
too high.

 There is interference on 
the sensor signal.

 Check the value for 
FORCE_GAIN.

 Check the connection be-
tween the SDC and the 
RDC box.

 Check the resolver-sensor 
cable.

No force rise in force control Force sensor defective. Exchange the weld gun motor.

SDC defective. Check the connection 
between the SDC and the 
RDC box.

 Sensor reset is set contin-
uously.

 No connection between 
force sensor and SDC.

 Check the connection be-
tween the SDC and the 
RDC box.

 Check the force sensor.

 Check the resolver-sensor 
cable.

Gun moves force-controlled less 
than FORCE_LIM

The force dropped below the 
lower monitoring limit while 
the weld gun was under force 
control.

 Value for FORCE_GAIN 
too high.

 There is interference on 
the sensor signal.

 Check the value for 
FORCE_GAIN.

 Check the connection be-
tween the SDC and the 
RDC box.

 Check the resolver-sensor 
cable.
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10.4 Error messages caused by the weld timer / configuration

Message text Cause Remedy

No cycle end signal, input 
{No.}

No end of weld signal present. Check:

 I/O configuration

 Incorrect signal declara-
tion

 Bus configuration

 Hardware

Incorrect signal declaration

Incorrect I/O configuration Check I/O configuration.

Welding controller error, input 
{No.}

Weld timer error Refer to the weld timer hand-
book

Incorrect I/O configuration Check I/O configuration.

Welding start signal is already 
true, output {No.}

The weld start signal is 
already set before the start of 
welding. 

Check weld timer, manually 
reset weld start signal and 
repeat welding.

Cycle end has not been reset, 
input {No.}

The weld start signal is 
already set before the start of 
welding.

Check weld timer.

Incorrect I/O configuration Check I/O configuration.

Incorrect program number! The selected program index is 
out of range.

 Check program index.

 Check signal definition of 
the program index.

No TIMER READY signal, 
input {No.}

Weld timer is switched off, dis-
connected or defective.

Check weld timer, connecting 
cables and power supply.

Incorrect I/O configuration Check I/O configuration.

No CURRENT ON signal, 
input {No.}

Weld timer defective Check weld timer.

Incorrect I/O configuration Check I/O configuration.

No water monitor 1 signal, 
input {No.}, repeat point?

No water monitor 2 signal, 
input {No.}, repeat point?

Defective flow monitor Check flow monitor.

Electrode tip pulled off. Check electrode tips.

Incorrect I/O configuration Check I/O configuration.

No THERMO CONTACT sig-
nal, input {No.}

Welding transformer defec-
tive.

Check welding transformer 
and connecting cables.

Open circuit at welding trans-
former

Incorrect I/O configuration Check I/O configuration.

Attention! Timer type is TEST! The timer type TEST is not 
permissible in EXT mode.

 Set the correct timer type.

 Change operating mode.

Process monitoring is dis-
abled, input {No.}

Weld timer defective Check weld timer.

Process monitoring signal is 
not set.

Set process monitoring signal.

Incorrect I/O configuration Check I/O configuration.
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10.5 Error messages caused by the force sensor

Message text Cause Remedy

Caution!!! Sensor could not be 
reset!

Force sensor defective. Exchange the weld gun motor.

SDC defective or not present. Check the connection 
between the SDC and the 
RDC box.

Resolver-sensor cable is inter-
rupted.

Check the resolver-sensor 
cable.

Field bus module defective or 
wrongly configured.

Check the field bus module.

No sensor values available! Resolver-sensor cable is 
incorrectly connected or 
defective.

Check the resolver-sensor 
cable.

Force sensor defective. Exchange the weld gun motor.

Measuring range of the force sen-
sor exceeded

Resolver-sensor cable inter-
rupted.

Check the resolver-sensor 
cable and/or exchange.

SDC defective or not correctly 
connected.

Check the SDC. Check the 
connection between the SDC 
and the RDC box.

Force sensor defective. Exchange the weld gun motor.
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11 KUKA Service

11.1 Requesting support

Introduction The KUKA Roboter GmbH documentation offers information on operation and 
provides assistance with troubleshooting. For further assistance, please con-
tact your local KUKA subsidiary.

Information The following information is required for processing a support request:

 Model and serial number of the robot

 Model and serial number of the controller

 Model and serial number of the linear unit (if applicable)

 Version of the KUKA System Software

 Optional software or modifications

 Archive of the software

 Application used

 Any external axes used

 Description of the problem, duration and frequency of the fault

11.2 KUKA Customer Support

Availability KUKA Customer Support is available in many countries. Please do not hesi-
tate to contact us if you have any questions.

Argentina Ruben Costantini S.A. (Agency)

Luis Angel Huergo 13 20

Parque Industrial

2400 San Francisco (CBA)

Argentina

Tel. +54 3564 421033

Fax +54 3564 428877

ventas@costantini-sa.com

Australia Headland Machinery Pty. Ltd.

Victoria (Head Office & Showroom)

95 Highbury Road 

Burwood

Victoria 31 25

Australia

Tel. +61 3 9244-3500

Fax +61 3 9244-3501

vic@headland.com.au

www.headland.com.au
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Belgium KUKA Automatisering + Robots N.V.

Centrum Zuid 1031

3530 Houthalen

Belgium

Tel. +32 11 516160

Fax +32 11 526794

info@kuka.be

www.kuka.be

Brazil KUKA Roboter do Brasil Ltda.

Avenida Franz Liszt, 80

Parque Novo Mundo

Jd. Guançã

CEP 02151 900 São Paulo

SP Brazil

Tel. +55 11 69844900

Fax +55 11 62017883

info@kuka-roboter.com.br

Chile Robotec S.A. (Agency)

Santiago de Chile

Chile

Tel. +56 2 331-5951

Fax +56 2 331-5952

robotec@robotec.cl

www.robotec.cl

China KUKA Automation Equipment (Shanghai) Co., Ltd.

Songjiang Industrial Zone

No. 388 Minshen Road

201612 Shanghai

China

Tel. +86 21 6787-1808

Fax +86 21 6787-1805

info@kuka-sha.com.cn

www.kuka.cn

Germany KUKA Roboter GmbH

Zugspitzstr. 140

86165 Augsburg

Germany

Tel. +49 821 797-4000

Fax +49 821 797-1616

info@kuka-roboter.de

www.kuka-roboter.de
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France KUKA Automatisme + Robotique SAS

Techvallée

6, Avenue du Parc

91140 Villebon S/Yvette

France

Tel. +33 1 6931660-0

Fax +33 1 6931660-1

commercial@kuka.fr

www.kuka.fr

India KUKA Robotics India Pvt. Ltd.

Office Number-7, German Centre,

Level 12, Building No. - 9B

DLF Cyber City Phase III

122 002 Gurgaon

Haryana

India

Tel. +91 124 4635774

Fax +91 124 4635773

info@kuka.in

www.kuka.in

Italy KUKA Roboter Italia S.p.A.

Via Pavia 9/a - int.6

10098 Rivoli (TO)

Italy

Tel. +39 011 959-5013

Fax +39 011 959-5141

kuka@kuka.it

www.kuka.it

Japan KUKA Robotics Japan K.K.

Daiba Garden City Building 1F

2-3-5 Daiba, Minato-ku

Tokyo

135-0091

Japan

Tel. +81 3 6380-7311

Fax +81 3 6380-7312

info@kuka.co.jp

Korea KUKA Robotics Korea Co. Ltd.

RIT Center 306, Gyeonggi Technopark

1271-11 Sa 3-dong, Sangnok-gu

Ansan City, Gyeonggi Do

426-901

Korea

Tel. +82 31 501-1451

Fax +82 31 501-1461

info@kukakorea.com
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Malaysia KUKA Robot Automation Sdn Bhd

South East Asia Regional Office

No. 24, Jalan TPP 1/10

Taman Industri Puchong

47100 Puchong

Selangor

Malaysia

Tel. +60 3 8061-0613 or -0614

Fax +60 3 8061-7386

info@kuka.com.my

Mexico KUKA de Mexico S. de R.L. de C.V.

Rio San Joaquin #339, Local 5

Colonia Pensil Sur

C.P. 11490 Mexico D.F.

Mexico

Tel. +52 55 5203-8407

Fax +52 55 5203-8148

info@kuka.com.mx

Norway KUKA Sveiseanlegg + Roboter

Sentrumsvegen 5

2867 Hov

Norway

Tel. +47 61 18 91 30

Fax +47 61 18 62 00

info@kuka.no

Austria KUKA Roboter Austria GmbH

Vertriebsbüro Österreich

Regensburger Strasse 9/1

4020 Linz

Austria

Tel. +43 732 784752

Fax +43 732 793880

office@kuka-roboter.at

www.kuka-roboter.at

Poland KUKA Roboter Austria GmbH

Spółka z ograniczoną odpowiedzialnością

Oddział w Polsce

Ul. Porcelanowa 10

40-246 Katowice

Poland

Tel. +48 327 30 32 13 or -14

Fax +48 327 30 32 26

ServicePL@kuka-roboter.de
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Portugal KUKA Sistemas de Automatización S.A.

Rua do Alto da Guerra n° 50

Armazém 04

2910 011 Setúbal

Portugal

Tel. +351 265 729780

Fax +351 265 729782

kuka@mail.telepac.pt

Russia OOO KUKA Robotics Rus

Webnaja ul. 8A

107143 Moskau

Russia

Tel. +7 495 781-31-20

Fax +7 495 781-31-19

kuka-robotics.ru

Sweden KUKA Svetsanläggningar + Robotar AB

A. Odhners gata 15

421 30 Västra Frölunda

Sweden

Tel. +46 31 7266-200

Fax +46 31 7266-201

info@kuka.se

Switzerland KUKA Roboter Schweiz AG

Industriestr. 9

5432 Neuenhof

Switzerland

Tel. +41 44 74490-90

Fax +41 44 74490-91

info@kuka-roboter.ch

www.kuka-roboter.ch

Spain KUKA Robots IBÉRICA, S.A.

Pol. Industrial

Torrent de la Pastera

Carrer del Bages s/n

08800 Vilanova i la Geltrú (Barcelona)

Spain

Tel. +34 93 8142-353

Fax +34 93 8142-950

Comercial@kuka-e.com

www.kuka-e.com
87 / 93Issued: 10.04.2012 Version: KST ServoGun FC 2.0 V4 en



88 / 93

KUKA.ServoGun FC 2.0
South Africa Jendamark Automation LTD (Agency)

76a York Road

North End

6000 Port Elizabeth

South Africa

Tel. +27 41 391 4700

Fax +27 41 373 3869

www.jendamark.co.za

Taiwan KUKA Robot Automation Taiwan Co., Ltd.

No. 249 Pujong Road

Jungli City, Taoyuan County 320

Taiwan, R. O. C.

Tel. +886 3 4331988

Fax +886 3 4331948

info@kuka.com.tw

www.kuka.com.tw

Thailand KUKA Robot Automation (M)SdnBhd

Thailand Office

c/o Maccall System Co. Ltd.

49/9-10 Soi Kingkaew 30 Kingkaew Road

Tt. Rachatheva, A. Bangpli

Samutprakarn

10540 Thailand

Tel. +66 2 7502737

Fax +66 2 6612355

atika@ji-net.com

www.kuka-roboter.de

Czech Republic KUKA Roboter Austria GmbH

Organisation Tschechien und Slowakei

Sezemická 2757/2

193 00 Praha

Horní Počernice

Czech Republic

Tel. +420 22 62 12 27 2

Fax +420 22 62 12 27 0

support@kuka.cz

Hungary KUKA Robotics Hungaria Kft.

Fö út 140

2335 Taksony

Hungary

Tel. +36 24 501609

Fax +36 24 477031

info@kuka-robotics.hu
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USA KUKA Robotics Corp.

22500 Key Drive

Clinton Township

48036 

Michigan

USA

Tel. +1 866 8735852

Fax +1 586 5692087

info@kukarobotics.com

www.kukarobotics.com

UK KUKA Automation + Robotics

Hereward Rise

Halesowen

B62 8AN

UK

Tel. +44 121 585-0800

Fax +44 121 585-0900

sales@kuka.co.uk
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$SET_IO_SIZE 31, 33

A
Approximate positioning 70, 71

B
Burn-off 8, 50

C
Calibration 8
Calibration step 39
Calibration, force sensor 40
Characteristics 41
Closing, gun 22
Collision detection 69
Compensation 8
Compensator (status key) 21
Configuration 25
Configuration, entering values 29
Configuration, inputs 31
Configuration, loading 30
Configuration, outputs 33
Configuration, start-up 25
Connecting cables 13
Connector X52 14
Controller parameters, overview 51
Couple (status key) 22
Coupling 22, 68
Cyclical initialization 9
Cyclical initialization (status key) 21

D
Decouple (status key) 22
Decoupling 22, 68
Diagnosis 73
Documentation, industrial robot 7
Dressing 8
Dressing, programming 63

E
EG_CAL_F 40
EG_FLEXXX 75
EG_FORCE_F 40
EG_NON_KUKA_DRESS 63, 66, 71, 77
EG_RECAL_F 40
EG_SET_FORCE_PARAM 52, 54
EG_SET_MOTOR_PARAM 52, 53
EG_TOUCH_DIFF 60
Electrical connections, motor 14
EqualizingTech 11, 17, 25, 57, 78
EqualizingTech, tip dressing 66
EqualizingTech, weld spot 59
Error messages, overview 79
Exchangeable gun 9

F
First initialization 8, 26, 50, 61

First initialization (status key) 21
Force characteristic 41
Force control 8, 12
Force gauge 8
Force gauge, thickness 34, 38
Force sensor 8, 12, 40
Force test 40
Functional principle 12

G
Gear ratio 9, 37
Gun (status key) 21
Gun flexion 9, 40, 75
Gun flexion characteristic 42
Gun, fixed 57
Gun, stationary 57

H
Hardware 19

I
Initialization, cyclical 50, 61
Initialization, overview 50
Initialization, programming 61
Inline forms, overview 57
Installation 19
Interpolation mode 69
Introduction 7

K
KUKA Customer Support 83

M
Mastering 8
Mastering, manual 37
Menus 21
Messages 79

N
Name for gun, entering 29

O
Opening, gun 22
Operation 21
Orientation control 71

P
Pole pair 8
Position control 8, 12
Product description 11
Programming 57
Programming, tip dressing 66
Programming, weld spot 59

R
Required knowledge and skills 7
Reset 8
Reset, testing 38
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Residual travel 8, 45

S
Safety 17
Safety instructions 7
SDC 8, 19
Service, KUKA Roboter 83
Servo Digital Converter 8
Servo file 35
Servo gun 8
Software 19
Software limit switches, checking 45
Software limit switches, setting 44
Start-up 25
Start-up, overview 25
Status keys 21
Subprograms, adaptable 71
Support request 83
System requirements 19
System variables 77

T
T1, welding 57
Target group 7
TCP correction 34, 50
Terms used 8
Tip dresser, thickness 64, 65, 67
Tip dressing 8, 63
Tip initialization, overview 50
Tip wear 35
Tip wear, compensation 34
Tool direction 29, 34
Trace 8, 51
Trademarks 8
Training 7

U
Uninstalling ServoGun FC 20

V
Variables, EG_EXTERN.DAT 77
Variables, kernel system 78

W
Warnings 7
Water monitor 9
Weld controller 8
Weld timer 8
Welding cell 11
Welding process 12
Welding, programming 58
WorkVisual 11
Issued: 10.04.2012 Version: KST ServoGun FC 2.0 V4 en



93 / 93Issued: 10.04.2012 Version: KST ServoGun FC 2.0 V4 en

KUKA.ServoGun FC 2.0


	KUKA.ServoGun FC 2.0
	1 Introduction
	1.1 Target group
	1.2 Industrial robot documentation
	1.3 Representation of warnings and notes
	1.4 Trademarks
	1.5 Terms used

	2 Product description
	2.1 ServoGun FC – overview
	2.2 Functional principle
	2.3 Overview of connecting cables
	2.4 Electrical connections on the weld gun motor
	2.5 Connector pin allocation X52

	3 Safety
	4 Installation
	4.1 System requirements
	4.2 Installing ServoGun FC
	4.3 Uninstalling ServoGun FC

	5 Operation
	5.1 Menus
	5.2 Status keys
	5.3 Manually opening / closing the gun
	5.4 Manually coupling / decoupling the gun
	5.5 Manually activating gun compensation
	5.6 Calling the variable overview

	6 Start-up and configuration
	6.1 Start-up and configuration – overview
	6.2 Configuration in WorkVisual – overview
	6.2.1 Controller bus configuration for KUKA.ServoGun FC
	6.2.2 Configuring the gun

	6.3 TCP calibration and tool direction
	6.4 Setting configuration parameters
	6.4.1 Loading gun data from a TXT file
	6.4.2 Saving gun data in a TXT file
	6.4.3 Configuration parameters
	6.4.3.1 “Inputs” screen
	6.4.3.2 “Outputs” screen
	6.4.3.3 “Configuration” screen
	6.4.3.4 “Gun parameters” screen
	6.4.3.5 “Force control” screen


	6.5 Manual gun mastering
	6.6 Determining the gear ratio
	6.7 Determining the thickness of the force gauge
	6.8 Testing the sensor reset
	6.9 Determining the calibration step size
	6.9.1 Calculating the first calibration position and the calibration step size

	6.10 Calibrating the force sensor
	6.10.1 Coarse calibration with EG_CAL_F program
	6.10.2 Description of coarse calibration
	6.10.3 Force test with EG_FORCE_F program
	6.10.4 Fine calibration with the EG_RECAL_F program

	6.11 Setting the software limit switches
	6.11.1 Setting the negative software limit switch
	6.11.2 Setting the positive software limit switch

	6.12 Checking the residual travel and software limit switches
	6.12.1 Dimensions and distances on a C gun
	6.12.2 Checking the residual travel and software limit switches for C guns
	6.12.3 Checking the residual travel and software limit switches for X guns

	6.13 Tip initialization – overview
	6.13.1 First initialization via status key
	6.13.2 Cyclical initialization via status key

	6.14 Controller parameters – overview
	6.14.1 Optimizing the parameters for the speed and position controllers
	6.14.2 Optimizing the parameters for the force controller


	7 Programming
	7.1 Inline forms – overview
	7.2 Instructions
	7.2.1 Instructions for use of stationary guns

	7.3 Programming a weld spot
	7.3.1 Inline form “SPOT”

	7.4 Programming a weld spot with EqualizingTech
	7.4.1 Inline form “SPOT” (EqualizingTech)

	7.5 Programming tip initialization
	7.5.1 Programming first initialization
	7.5.2 Programming cyclical initialization
	7.5.3 Inline form “INIT”

	7.6 Programming tip dressing
	7.6.1 Determining the thickness of the tip dresser
	7.6.2 Inline form “TippDress”

	7.7 Programming tip dressing with EqualizingTech
	7.7.1 Inline form “TippDress” (EqualizingTech)

	7.8 Inline form ServoGun Decouple
	7.9 Inline form ServoGun Couple
	7.10 Option window “Frames”
	7.11 Option window: Motion parameters (PTP)
	7.12 Option window: Motion parameters (LIN, CIRC)
	7.13 Adaptable subprograms

	8 Diagnosis
	8.1 Carrying out tests
	8.2 Description of the tests
	8.3 Determining the gun flexion (independently of the force sensor)

	9 System variables
	9.1 Important variables in EG_EXTERN.DAT
	9.2 Important kernel system variables

	10 Messages
	10.1 Overview of error messages
	10.2 Error messages caused by the weld gun
	10.3 Error messages caused by force control
	10.4 Error messages caused by the weld timer / configuration
	10.5 Error messages caused by the force sensor

	11 KUKA Service
	11.1 Requesting support
	11.2 KUKA Customer Support

	Index


